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DEALS COLUMN
from the DealsGuy

Greater Orlando Computer UG
by Bob “The Cheapskate” Click

Lightning Fast Trades
Here’s an interesting article for 
investors. It explains how modern 
technology has progressed to the point 
where stock trades are now processed 
almost at the speed of light. I found 
it very enlightening <http://www.
informationweek.com/showArticle.
jhtml;jsessionid=R3M3IYXUGJSZG
QSNDLOSKHSCJUNN2JVN?article
ID=199200297&queryText=Richard+
Martin>.
Microsoft Plays Catch-Up
It’s hard to think of Microsoft being 
behind the times in technology, but that 
is said to be the case in Web interface 
design. Adobe’s Flash has prevailed 
so far, but Microsoft will introduce a 
competitor called “Silverlight” and 
some tools called Expression Studio 
that sound interesting. After I read 
about this in InformationWeek, I saw 
more in the 5/21/07 “Microsoft At A 
Glance” newsletter. They made mention 
of those products and gave the URL to 
watch a video and download the beta 
version of Silverlight. It is referred 
to as a “cross-browser and cross-
platform plug-in.” They also included 
the URL for the Expression Studio 
design products <http://go.microsoft.
com/?linkid=6824909> where you 
can download free trials. There was 
other information included in that 
newsletter.
Another Use For Wi-Fi
On another note, I have always thought 
of Wi-Fi as a connection for my laptop, 
or a broadband installation of some 
kind, but one particularly well traveled 
�

rail route in southern California will 
be getting Wi-Fi for security purposes. 
Because railroads often traverse very 
remote areas, this project is a difficult 
one and includes some solar powered 
nodes. Vandalism is a problem in the 
area getting that installation. I have 
often wondered how good the cell 
phone service was on some rail routes 
that are less traveled and have remote 
routes. Some cruise ships offer limited 
cell phone service and it is slowly being 
introduced on airlines, but not without 
resistance from the airlines and from 
the public. I know I wouldn’t want 
the person next to me talking on a cell 
phone for the entire trip.
Reminder
Again, the announcements below are 
written by the PR people and I edit to 
shorten them and try to improve on 
the wording. I have not tried any of 
these products so check their Web site 
carefully and do your homework if you 
are interested.
This Add-On For Microsoft Windows 
Might Help
Addintools announced the release of 
Classic Menu for Office 2007 v.2.18, 
a user interface enhancement add-on 
for Microsoft Office 2007. The new 
interface will replace the system of 
layered menus, toolbars and task panes 
with a so-called Ribbon. It lets users 
retrieve and show the main menu bar, 
standard toolbar, and formatting toolbar 
that are hidden or moved away from 
direct view. The program works with 
Word, Excel, and PowerPoint. All new 
Office 2007 features remain accessible 
in the classic menu and toolbars.

Classic Menu for Office 2007 also 
lets users add the menus and toolbars to 
the Quick Access Toolbar so it becomes 
possible to minimize the Ribbon and 
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finish all operations without having to 
open it again. The program has been 
optimized for complete compatibility 
with Microsoft Office 2007 and supports 
all major languages, including English, 
French, German, Italian, Spanish, 
Portuguese, Japanese, Arabic, Korean, 
and Chinese.

Classic Menu for Office 2007 
v.2.18 runs under Microsoft Windows 
XP/2003/Vista and costs $29.95 (USD) 
for a single-user license. User group 
members receive 15% discount on the 
purchase of Classic Menu for Office 
2007 v2.18 by entering coupon code 
ADDI-CARU into the coupon box on 
the order page. Licensed customers are 
entitled to free updates and technical 
support for 2 years after the date of 
purchase.

Product page link: <http://www.
addintools.com/english/menuoffice> 

Direct download link: <http://www.
addintools.com/english/menuoffice/
Setup_OfficeMenu.exe> (2.62 MB)

Company website: <http://www.
addintools.com>.
File Recovery Product, Might Help In 
Some Circumstances
Enplase Research Corporation has 
announced the immediate availability 
of MultiStage Recovery 2.8 that will 
recover any file and back it up to a hard 
disk drive. MultiStage Recovery lets 
users recover all recoverable files (20 
gigabytes in 20 seconds!) The program 
supports all Windows file systems 
and comes with a built-in preview 
for over 60 file formats. Designed as 
do-it-yourself data recovery software, 
MultiStage Recovery will restore all 
file types including audio, images, 
and documents. It supports all FAT12/
VFAT/16/32 and NTFS/NTFS5 file 
systems used by Microsoft Windows. 
�

It helps users restore precious data if 
files are lost due to a virus, malicious 
hacker attack or an operating system 
crash in which a hard disk drive has 
not experienced physical damage, and 
restores files from any brand of hard 
disk drive and type of storage media, 
including hard disks, floppy disks, flash 
drives, and digital camera cards.

MultiStage Recovery 2.8 runs under 
Microsoft® NT 4.0 (with SP4), 2000, 
XP, 2003, Vista and costs $39.95 (US) 
for a single-user license. User group 
members get 20% off by using the 
coupon code 8192 (making it $31.96) at 
<http://enplase.com/pages/BuyProduct/
ProductName-MultiStage+Recovery.
html>. For other types of licenses, 
please refer to Enplase’s Software Store 
at <http://enplase.com/pages/Purchase.
html>. Additional information on the 
product, as well as its free evaluation 
copy is available from <http://enplase.
com/>. Product page link: <http://
enplase.com/pages/MultiStage+Recov
ery+description.html>.
I Am Not A Fan Of Screensavers, But 
Here Is An Announcement
DealsGuy Note: Screensavers have 
long been known to sometimes cause 
problems so I don’t use them. Also, 
this company only offers a discount 
for purchasing more than one, but I am 
including it because there are certainly 
fans for screensavers, and I get asked for 
deals on them quite frequently.

FancyBytes Software announces 
the release of Dolphin Aqua Life 3D 
Screensaver 3.0, Shark Water World 3D 
Screensaver 1.5, and Mountain Lake 
Waterfall Screensaver 1.0. Unique to 
these screensavers is their dual monitor 
support and sleek 3D graphics. If 
you have two monitors installed on 
your system, you likely have already 
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looked for screensavers that can fit 
your configuration. With FancyBytes 
Software you can now enjoy beautiful 
3D screensavers with dual monitor 
support. Of course, the screensavers 
will look nice on a single screen, but 
with two monitors, you’ll receive a 
continuous panoramic image, showing 
the aquatic world in all its beauty. Use 
these screensavers to make the most 
of your dual monitor system. The free 
trial downloads are available at <http://
www.fancybytes.com>. Below are the 
screensavers:
Dolphin Aqua Life 3D Screensaver
Travel to the sea bottom with the most 
intelligent inhabitant of the sea, the 
dolphin. See the amazing play of light 
on its skin as light creates interesting 
patterns on the sea floor, which is 
covered with age-old rocks and shells. 
This dignified creature and a variety of 
small fishes leisurely swim back and 
forth, as you admire the aquatic scenery 
and take a rejuvenating rest. 
Shark Water World 3D Screensaver
Find the remnants of ships that once 
belonged to unlucky Caribbean pirates 
who now lie in Davy Jones’ Locker. 
Chests containing countless riches 
peacefully lie on the sea floor, but watch 
out for the sharks! These hunters guard 
the treasures from anyone who would 
dare steal their gold.
M o u n t a i n  L a k e  Wa t e r f a l l 
Screensaver
See the pristine beauty of Mother Nature. 
Stand in awe of the majestic waterfall 
tumbling into a clear mountain lake. 
Unwind to the sounds of murmuring 
water. Admire the picturesque lake 
scenery and nearby forest. Just the kind 
of place you’ve been wanting for some 
rest and relaxation? 
�

Dolphin Aqua Life 3D Screensaver 
costs $19.95 (USD). Shark Water World 
3D Screensaver costs $19.95 (USD). 
Mountain Lake Waterfall Screensaver 
costs $14.95 (USD). For a discount on 
two or more of the registered versions 
of these products, please visit; <http://
www.fancybytes.com/orders_special.
html>. All prices are for a single-user 
license. The screensavers run under 
all versions of Microsoft Windows. 
Licensed customers are entitled to 
the fully functional version of the 
product, free technical support and free 
upgrades. Additional information on 
the screensavers, as well as free trial 
copies are available from <http://www.
fancybytes.com>. 

Product pages
<http://www.fancybytes.com/

a b o u t _ d o l p h i n _ a q u a _ l i f e _ 3 d _
screensaver.html>  

<http://www.fancybytes.com/
about_shark.html> 

<http://www.fancybytes.com/
about_mountain_lake_waterfall_
screensaver.html> 

D i r e c t  d o w n l o a d  l i n k :  
<http://www.fancybytes.com> Click the 
Download buttons for the desired file.

That’s it for this month. I’ll have 
more new product announcements on 
my Web site (not offering a discount). 
Meet me here again next month if your 
editor permits. This column is written 
to make user group members aware 
of special offers or freebies I have 
found or arranged, and my comments 
should not be interpreted to encourage, 
or discourage, the purchase of any 
products, no matter how enthused I 
might sound. Bob (The Cheapskate) 
Click <bobclick@mindspring.com>. 
Visit my Web site at <http://www.
dealsguy.com>
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Ever since Mr. Microsoft decided that he couldn’t afford manuals for his software, 
there has been a grand opening for windbags to write 1,000 page books without 
saying all that much. This article results from a bet that a bloated chapter on 
tabbing and indenting in Microsoft Word could be done in 10% of that space, and 
tell more. 
History

On an old-fashioned typewriter, the only way to insert multiple spaces was with 
the tab key. Ordinarily, each press would advance you 5 spaces. That was only 
the default but we didn’t yet know that word then. The main purpose of tabbing, 
then and now, was to indent text. It was also the only way to make tables. Today, 
things are a lot different. You can still set tab stops manually, which now come in 
assorted fancy flavors, and you still hit the Tab key to get there, but the need for 
them is much reduced. The indent function has been taken over by various indent 
commands; the tabular function by the table commands.

The direct indenting commands can cause some confusion as compared to 
old-fashioned tabs, because they sometimes use tab stops and sometimes not, 
and they use some tab stops but not others. Also, like all software, some of their 
aspects are counterintuitive, so it’s easy to start on the wrong foot, for which Word 
will punish you. 

The following sections will untangle this:
Setting tab stops
The relation between tabs and indents 
Tabbing on the fly vs. using styles

Setting tab stops
Vocabulary
Margins	 distance from edge of the page to the text; set in File-menu→Page Setup. 

Also the strip on the page defined by this distance.  
You can set left, right, top and bottom margins. If you set the left margin 
at 1", a tab stop at 0.5" will land on the paper at 1.5".

Tab mark	 when you hit the Tab key to move to the next Tab stop, Word puts 
a mark in the text, which you can see as a “→” by turning on Show 
Formatting Marks in Tools → Options → View tab → Formatting 
marks section or by clicking the ¶ icon in the formatting toolbar if 
you have it displayed. When you set an indent, there is no such mark. 
Ordinarily, this is not important, except when you are trying to fix in 
your mind that a tab is not the same as an indent. 

Indent	 noun: the empty space from the left margin point (say 1") to the start 
of the text. We also speak of first line indents, right indents and more.  
Verb: causing the above indents, often by pressing the Tab key 

�.
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The Little Tab Key That Could 
By Al Gruber
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Ruler	 tape-measure-like strip that divides Word’s command stuff from your text.  
It can be shown or hidden by clicking View-menu → Ruler.  
Turn it on to see the various tab-related markers discussed here. Its 
full name is the “horizontal ruler” to distinguish it from the “vertical 
ruler” which does not concern us.

Cursor vs. 
I-bar: 	 The Cursor is what moves when you move the mouse. If you click 

the cursor in text, it deposits a flashing vertical bar (the I-bar), which 
tells you where the next letter will land. Some call this the “Insertion 
point.”

Where to set tab stops
Word usually has three or four different ways to do any single thing and tab stops 
are no exception. They can be set at:

Format-menu → Paragraph → 
Tabs button, or

Format-menu → Tabs, or
Click, drag icons on the ruler

The Default tab stops field:
The 0.5" in that field means that 
as shipped, Word has a tab stop 
every ½". 

If you have set a left page margin 
of 1", then the first stop will be at 
1.5", measured from the left edge of 
the page. Manually set stops are of 
course measured the same way. To use 
centimeters, or other units, instead of 
inches, see Tools menu → Options → 
General tab. 

If you enter a manual stop at the 2" point, it cancels the three defaults stops to 
its left (at 0.5", 1", and 1.5"). This is a gotcha: don’t count on defaults to the left of 
where you plan to place a manual stop. But hold it: the default tab stops can also 
be used by the indent commands, and there, manual stops don’t cancel them. 

If you change the default setting to say every ⅓", this will apply only to the 
current document. To change the default for all new documents, you must edit the 
document template—not covered here. 

The rest of the Tabs dialog box is used to enter tab stops manually. But why do 
that? If you need stops at 2" and 4", you could just as easily give the Tab key a few 
extra hits. One answer is that manual stops have certain exclusive features. Even 
more important, positional adjustments are easier with two manual stops instead 
of eight defaults. Manual stops will simplify your life. 
The Enter/Edit field; The Tab stops list (screenshot above):
The top line, see “Enter or Edit here”, works in tandem with the Tab stops list panel 
immediately below it. Entering the stop, say 3.5", doesn’t make it so until you click 
the set button to put it on the list. To set three tabs, you do three sets.  
�



To change a stop, you highlight it, click the Clear button, and then enter the 
replacement.
Tab stops to be cleared:
Notice this wording. They aren’t cleared yet. If you are used to closing screens 
by clicking the red x, don’t do it here. It means cancel. To make anything happen, 
you must click OK or hit Enter. 
Alignment:
Word has 5 types of tab stops. The first four align the text you type, as follows:
Left 	 the tab key moves the I-bar to this stop; then the letters you type go to 

the right as always. This is the most used tab stop. The rest are pretty 
much left over from the days of using tabs to make tables. 

Center	 the words you type get centered on this tab stop.
Right	 the words you type grow leftward so that the last letter sits on the tab 

stop.
Decimal	 if you enter $4,567.89, the decimal will sit on the tab stop. This can 

also be used with text for some special effects. I hear that if you buy 
Word in a country that uses commas as decimal points, this tab will 
center on the commas. 

Bar	 Puts a “|” at the tab stop, for drawing an old-fashioned table? 
Leaders:
These are used to visually connect left......................................................to right, 
page numbers for example. To apply a leader, click the tab stop then click the leader 
button. This feature also seems to be a leftover from making tables, especially 
Tables of Contents, which are nowadays automated.
Now the mystery; what do these settings set?
If you always work in a straight line and never need to add tab stops during editing, 
you can skip this part. Otherwise, read on. There is a gotcha here, caused by two 
Word features:

The tab settings, and most other important things, are stored in the paragraph 
marker—which can be seen as “¶” if you enable Tools → Options → View tab 
→ Show formatting markers. 
As you type, new paragraphs conveniently inherit these settings from the 
previous paragraph, but if you change a middle paragraph later, the next 
paragraph doesn’t do that inheriting. 
If you set a tab stop at the top before you start typing, it will apply to everything 

that follows. Then if you change it at some point, the new setting will apply from 
then on. It will seem to you that tab stops apply to sections of text, with new sections 
starting whenever you change the tab settings. 

But if you try the same thing during editing, setting a tab stop in paragraph 
one applies only to that paragraph, not to the whole document. This is not the end 
of the world so long as you know this behavior. You can select several paragraphs 
and specify tab stops for all of them. But if some of these paragraphs use default 
tab stops, the new manual stops will override them. Also, Word will only show 
the stops that are common to the selected paragraphs. If the paragraphs differ, you 
will have to alter each separately. 

�.
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Tabs vs. Indents 
The purpose of Word’s indenting commands is to eliminate the need to hit the 
tab key. Given say a 5-line paragraph to indent, the typewriter would need a tab 
at each line. Word, once set, not only indents each line in this paragraph, but in 
every succeeding paragraph, until you tell it otherwise.

There are three types of indents: 1. First line, 2. Paragraph indents, both left 
and right, and 3. Hanging indents.

First Line Indent, as the name says, indents the first line of a paragraph. 
This is used in many books, as an economical way to show the start of a new 
paragraph without requiring a separator line.

It is also used in some correspondence styles. In times past, it was a favorite but 
has now been largely replaced by what is known as block style. The DATA BUS 
uses first line indent. Block style just uses a blank line between paragraphs.

Indented paragraphs are often used for quoted materials. At minimum, 
they are indented on the left. For more impact, you can also right-indent. An 
additional flourish is to use a smaller typeface and apply full (left and right) 
justification. 

Hanging Indent	The opposite of a First Line Indent. The second and subsequent 
lines are indented. The space on the first line is optional but 
represents the most common and visually pleasing use of this 
feature. Rather than a hanging indent, you might think of this 
as a hanging paragraph. 

Where to set indents
As usual, there are several ways to set indents. The most complete is from the 
menu: 

Click Format → Paragraph > Indents and Spacing tab:
Our interest here 

is only the Indentation 
section. We have cut off 
the irrelevant bottom 
half. At the top, Outline 
level has nothing to 
do with indents, and 
Alignment is  only 
barely relevant.

To  u s e  t h e s e 
commands, place the cursor in the desired paragraph or line where you plan to 
type, or in the case of multiple paragraphs, select them. Then: 
Indentation, Left:	 Like tab stops, entering 1" here will place the start of the 

text 1" to the right of the page margin. If your left margin is 
set at 1", the text will start at 2". You can also set a negative 
indent: -0.5 will shift the start of the text ½” left; use it to 
temporarily change the Page Margin
�



Indentation, Right:	 Unlike tab stops, a 1" here will pull the end of the line 1" to 
the left. With a right margin setting of 1", the lines will end 
2" from the page edge, at 6.5" on 8.5"x11" paper. A negative 
indent of -0.5 will override the right Page Margin and let 
the line run to within ½” of the paper’s edge.

Special:	 This field offers 3 choices: First Line, Hanging, and None.
Indent First Line By	The amount you enter here is added to the left indent. If the 

left indent is 1" and your first line request is 0.5", the marker 
on the ruler will be at 1.5". On the paper, if you also have a 
left margin of 1", the first word will actually print at 2.5".

Indent Hanging By	 The numbers work exactly as above, except that here it is 
the 2nd and later lines that are indented, and the first line 
represents the left edge of the paragraph. 

Alignment	 The standard choices are: left, center, right, justified. Even 
specially indented paragraphs can be aligned—if you find 
a reason for it.

Once you turn on these settings, they continue paragraph to paragraph. To turn 
them off, go back to Format menu → Paragraph and change the Indents to 0 and 
the Special field to None.
Using the Ruler to set Tab Stops
Though the Tabs dialog box is more complete, setting tabs is faster and easier on 
the Ruler. If necessary, turn it on via View menu→Ruler.

Put the I-bar in the desired paragraph. If no text yet, put it on the desired line.
To place the stops accurately, scroll the paragraph up close to the ruler. 
To select the stop type (left, center, etc.), if it’s not set to what you want:  
•	 click on the  leftmost button and run through the choices;  
•	 hover over it to see the tool-tip that identifies it. 
To place the stop, click on the bottom border of the ruler, at the place you want.  
You can drag stops to adjust their placement; Alt-drag shows measurements; 
To remove a stop, drag it down into the text. 	  
(The stop on the ruler graphically tells its type. For what the graphic means, 
hover over the leftmost button. Move the cursor if the tool-tip is reluctant.) 
If you want a leader, click Format menu → Tab (Screenshot 1) while the I-bar 
is still in the paragraph.

Using the Ruler to set Indents

�.
�.
�.

4.

5.

 The only difference between tabs stops and indent stops is which symbol you 
choose on the leftmost button. There are 3 indent symbols:

First line indent:  
Hanging and Left Indent:  on the button,  on the ruler. The tool-tips call 

the square “Left Indent” and the triangle “Hanging Indent”, but the two never 
appear separately. 
10



There is a fourth symbol, Right Indent , but this is not a choice on the 
leftmost button. It just sits at the right edge of the ruler, waiting to be dragged to 
where you want it.
Here are some actual settings:

Paragraph indent just a bit more than 1”: 

Same paragraph indent plus first line indent of 0.5”: 

Same paragraph indent plus hanging indent of 0.5”: 
It may seem strange that the First Line marker is now left of the Hanging/Left 

marker, but it’s true: The Hanging Paragraph is indeed indented past the first line. 
Or to put it another way, the First Line marker shows where all the lines would 
start without the Hanging Indent.

You use these symbols just like the tab stops. To do a First Line indent:
put the I-bar on the desired text, 
click the leftmost button until you see the , 
then click the lower border of the ruler where you want the stop. 
To Left Indent a paragraph, do as above except the leftmost button must show 

the .
To combine Left Indent with Hanging or First line, make the ruler look like 

the examples above. 
Other ways to set indents
As you might have guessed, Word has several other ways to set indents. For typists 
who prefer to do everything from the keyboard, indents can also be set with the 
tab key.
But first, this must be enabled at:	  
Tools→Autocorrect→Autoformat As You Type tab→“Set left/first indent with 
Tabs” etc.

To set a First Line, type at least one word, then go back to the left edge and 
hit the Tab key. Word will move the First Line marker to the first default tab stop, 
and each additional hit will advance to the next default position. To reduce the 
number of keystrokes, it makes sense to permanently set your default tab stops to 
your customary First Line indent distance.

To set a Paragraph Indent, type at least two lines, then go to the left edge 
of the second line and hit the Tab key. The entire paragraph will move to the first 
default tab stop. Again, additional tabs will increase the indent.

To set a Hanging Indent, type the text that is to sit left of the hanging paragraph, 
then hit the tab key, which will this time cause an actual tab. If the I-bar does not 
land exactly where you want it, put in a manual tab stop using the “on the ruler” 
method described above. Then continue typing.

When you finish the paragraph, put the I-bar at the left edge of line two or 
later, and hit the tab key. Now the entire hanging paragraph will advance right, 
default tab stop by default tab stop, until it coincides with the stop on line one. 
This method assumes that you want a complete hanging paragraph, with a gap on 

�.
�.
�.
11



line one. To cancel or change these indent settings, put the I-bar at the place where 
you previously hit the Tab key, and hit Backspace instead. 

Another way to set or change indents is to drag the indent markers but this takes 
a sharp eye. Alt-drag shows measurements to make it a little easier. Also, undoing 
indents by dragging is sometimes frustrated by a first line indent marker that seems 
to have a mind of its own—really, it’s just doing what you asked it to. 

Finally, there are two useful buttons on the format toolbar, to the right of 
the bullet list button. These only do paragraph indents, but they are especially 
convenient because they work with the I-bar anywhere in the paragraph. Also, 
when undoing indents, they are guaranteed to get back to zero, instead of near-zero 
which is common if you drag.
Tabbing on the fly vs. using styles
The tone of this article suggests that you are tabbing and indenting on the fly, 
formatting your paragraphs as you feel the need. This is surely true for occasional 
and home typists. But in a business environment or for reports and books, a consistent 
look is more desirable than freedom of expression. The experts’ consistency tool is 
Word’s styles, by which you can create say a style named Hang2, which specifies 
indenting, typeface, space before and after the paragraph, and more. To use such 
a style, you pick it from the style field, the first drop-down on the format toolbar. 
The experts suggest a set of styles, FirstLine, LongCite, Dialog, whatever fits your 
taste and output. Creating these styles is of course a separate subject.

This article was based on Microsoft Word 2002 SP3, but should be applicable 
to all recent versions of Word. 

Al Gruber is a longtime member of SouthEastern Michigan Computer 
Organization, Inc. (SEMCO) and has written several articles for the DATA BUS. 
He gets his brief style from writing online help screens.
Apple’s New Safari 
Browser for WINDOWS

By Ira Wilsker

Apple recently released a free version 
of its Safari 3 browser for Windows. 
While this is the first public release of an 
Apple produced browser for Windows, 
many of us already have some Apple 
software on our computers. Many of us 
have viewed QuickTime videos on our 
computers, and QuickTime is a long-
standing Apple product.

One may ask why Apple would 
produce a browser for Windows, when 
there are other, well-established Windows 
browsers available. Microsoft’s Internet 
12
Explorer still has the vast majority of 
Windows browser market, followed 
in distant second by Firefox, and then 
Opera and Netscape. According to 
published reports, Apple sees Safari 
3 for Windows as a marketing tool to 
better acquaint Windows users with 
Apple products, in the hopes that they 
would buy more Apple offerings, such 
as the new iPhone. The default startup 
page for Safari, which is easy to change, 
is an Apple marketing and support 
website.

I already have four browsers installed 
on my main computer, with Firefox 
being my primary browser, followed 
by Internet Explorer with occasional 
use, and Opera and Netscape that I 



only rarely use. There is no conflict or 
problem having more than one browser 
installed, as they do not interfere with 
each other. Despite what I already 
have installed, curiosity dictated that I 
download and install Safari 3. Clicking 
on the download link at <http://www.
apple.com/safari> offered the choice 
of two Windows downloads, a 28 meg 
download of Safari with QuickTime 
for XP or Vista, or a smaller 8 meg 
download of just the Safari for XP and 
Vista. As may be already obvious, Safari 
for Windows will only run on computers 
with XP or Vista.

Apple has done a good job trying to 
create demand for Safari for Windows, 
by proximately posting relative 
performance information on the main 
Safari website. According to Apple, 
Safari can load web pages about twice 
as fast as Internet Explorer version 7, 
and 1.6 times faster than Firefox. Java 
scripts execute 2.8 times faster in Safari 
3 than they do in Internet Explorer 
7, and 1.6 times faster than Firefox. 
Application load time of Safari 3 is also 
faster than Internet Explorer or Firefox, 
while the much smaller Opera loads 
in about the same time as Safari 3. If 
Apple’s claimed performance advantage 
survives scrutiny of the trade media, 
then it may indeed have an edge in the 
highly competitive market.

I downloaded the full version 
of Safari 3 with QuickTime. And it 
installed smoothly with minimal effort. 
Upon loading Safari 3 the first time, 
it was immediately apparent that the 
look and feel of Safari is definitely 
Apple-esque. While the interface was 
clean and intuitive, it lacked some of 
the flair and color of Internet Explorer 
and Firefox, with a flat gray toolbar and 
border, which Apple calls “elegant.” 
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The commands and structure of the 
toolbar are similar to other browsers, 
and required a “zero” learning curve. As 
is now universal in other recent browser 
releases, Safari 3 offers tabbed browsing, 
where multiple browser windows can 
be sequentially opened in a single 
application. Safari 3 is a full featured 
browser, with easy to use bookmarks, 
an integral pop-up blocker, integrated 
search function, auto-completion of 
forms, a built in RSS reader, and other 
features. One somewhat unique feature 
is “SnapBack”, which allows the user to 
quickly return to previously viewed web 
pages more efficiently than using the 
“back” button. An interesting privacy 
feature is the “Private Browsing” 
feature (found in the “Edit” menu), 
which turns off any saving or record 
of websites visited (history), searches 
made, cookies received, forms filled, 
and other current information. In terms 
of security, Safari 3 supports all of the 
major Internet encryption standards, 
and proxy configurations. One feature 
I liked is that Safari 3 automatically 
imported the bookmarks from my 
other browsers, allowing me immediate 
access to the websites I typically visit 
using those other browsers.

Safari 3 allows the use of plug-ins, 
much like Firefox. Unlike the well-
established Firefox, with thousands 
of open source plug-ins available, the 
recently released Safari 3 only lists six 
plug-ins at its site at <http://www.apple.
com/safari/download/plugins.html>. 
These six plug-ins offer features that 
may already be integrated into other 
browsers, such as an Acrobat PDF 
viewer, Java, Flash viewer, Real Player, 
QuickTime, and Windows Media 
Player. As Safari 3 gains popularity 
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among Windows users, it is conceivable 
that more plug-ins may appear.

There is a potentially interesting 
feature built into Safari 3 that I 
personally do not yet feel comfortable 
with, but others may find very useful; 
this feature is “Bonjour for Windows.” 
Bonjour <http://www.apple.com/
bonjour> allows the user to network 
computers, printers, and other smart 
devices through the Safari 3 browser. 
Bonjour uses the open standard IP 
protocol, and can connect items hard 
wired through an Ethernet cable, or 
wirelessly through an 802.11 system. 
One example that Apple lists is using 
Bonjour to automatically configure 
a printer by going to an appropriate 
Bonjour compatible website, which 
provides the information to configure 
the printer. Apple lists printers from 
Brother, Canon, Epson, HP, Lexmark, 
and Xerox that are compatible with the 
Bonjour feature.

In using Safari 3 for Windows for 
a few days, I noticed some interesting 
usability features. One I especially liked 
was the feature that allows the size of 
the screen fonts to be instantly changed, 
which may improve readability of a web 
page. The feature in Safari 3 is identical 
to the same feature in Firefox, and uses 
the same command (CTRL +) to make 
the fonts larger, and “CTRL –” to make 
them smaller. This feature in Safari 3 
is superior and more flexible than the 
method used in Internet Explorer to 
change font sizes. In terms of readability, 
most web sites were easier to read in 
Safari 3 than in Internet Explorer 7. I did 
notice some minor negative difference 
between Safari and the others, and that 
was in terms of page formatting. One 
minor annoyance was displayed when 
viewing my weather page <http://www.
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beaumontweather.com> which is 
written in fairly pure HTML, the basic 
web page language. On Safari 3 some 
items that used the HTML “center” 
command did not appear centered, while 
the same items looked fine in Firefox or 
Internet Explorer. On some other pages, 
such as the starting page for a local TV 
station, some graphics do not appear to 
load at first, but this is usually rectified 
by reloading the page. Except for these 
anomalies, almost all other web pages 
I visited appeared correctly, and were 
very readable.

I found Safari 3 to be an attractive 
alternative to Internet Explorer, and may 
be of interest to those who might want 
to try something different in terms of 
a browser. It is clean and full featured, 
as is typical for Apple products. As 
another free browser, users may want 
to download it and try it.
WEBSITES:
<http://www.apple.com/safari>
<http://www.apple.com/safari/down-
load/plugins.html>

Ira Wilsker is an APCUG director; 
Columnist, The Examiner, Beaumont 
TX; Program Director of Management 
Development at the Lamar Institute 
of Technology, Beaumont TX; and a 
radio & TV show host. Contact him at 
<iwilsker@apcug.net>.

[Three security holes in Safari for 
Windows were reportedly found within 
hours of its release and more holes have 
reportedly been found since. Several of 
these flaws are claimed to be applicable 
to Safari on OSX also. To Apple’s credit, 
they responded quickly to the discovery 
of the flaws and have released fixes 
for Safari for Windows in the form  of 
version 3.0.1. It should be remembered 
that Safari for Windows is still in Public 
Beta. —Ed.]
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These online spoofs and shams have 
made the rounds on Web sites and 
through e-mail. Perhaps you even 
believed one or two of them yourself.

Obtained from APCUG with the 
author’s permission for publication by 
APCUG member groups.

Though some of these deceptions 
originated years ago, the originals—
and dozens of variants—continue to 
make the rounds. If you keep a patient 
vigil over your e-mail, you too may 

The Top 25 Web Hoaxes 
and Pranks

By Steve Bass, PC World 
Columnist and Author
Image courtesy of Snopes.com.
eventually spot a message urging 
you to FORWARD THIS TO 
EVERYONE YOU KNOW!!! And 
if you haven’t had enough when 
you finish reading this article, take a 
hoax test at the Museum of Hoaxes, 
and then hop over to Snopes, 
the premier myth-dispelling site 
for coverage of zillions of other 
falsifications.
Hoaxes 1 Through 5

From the supposed last photo taken at 
the top of the World Trade Center to the 
endlessly revised request for assistance 
from a Nigerian functionary, here are 
our top five Web and e-mail hoaxes.
1.	 The Accidental Tourist (2001)
Quite possibly the most famous hoax 
picture ever, this gruesome idea of 
a joke traveled around the Web and 
made a grand tour of e-mail inboxes 
everywhere soon after the tragedy 
of September 11. It depicts a tourist 
standing on the observation deck of 
one of the World Trade Center towers, 
unknowingly posing for a picture as an 
American Airlines plane approaches in 
the background.
1

At first glance, it appears to be real, 
but if you examine certain details, you’ll 
see that it’s a craftily modified image. 
For starters, the plane that struck the 
WTC was a wide-body Boeing 767; the 
one in the picture is a smaller 757. The 
approach of the plane in the picture is 
from the north, yet the building it would 
have hit—the North tower—didn’t 
have an outdoor observation deck. 
Furthermore, the South tower’s outdoor 
deck didn’t open until 9:30 a.m. on 
weekdays, more than half an hour after 
the first plane struck the WTC. The 
picture is a hoax, through and through—
and not a particularly amusing one, 
under the circumstances.
5

2.	 Sick Kid Needs Your Help (1989)
This gem had its roots in reality. It all 
began in 1989, when nine-year-old 
cancer patient Craig Shergold thought 
of a way to achieve his dream of getting 
into the Guinness Book of World 
Records. Craig asked people to send 
greeting cards, and boy, did they. By 
1991, 33 million greeting cards had been 
sent, far surpassing the prior record. 
Ironically, however, the Guinness 
World Records site doesn’t contain 
any mention of Craig Sherwood or a 
“most greeting cards received” record, 
presumably, because the fine folks at the 
site don’t want to encourage anyone to 



try to break his mark. (Astonishingly, 
Guinness doesn’t have an entry for 
world’s stoutest person, either, but it 
does honor the World’s Largest Tankard 
of Beer.)

Fortunately, doctors succeeded in 
removing the tumor, and Craig is now 
a healthy adult, but his appeal for cards 
has turned into the hoax that won’t die. 
Variations on the theme include a sick 
girl dying of cancer, and a little boy 
with leukemia whose dying wish is to 
start an eternal chain letter. A recent 
iteration tells a tragic tale of a girl 
who supposedly was horribly burned 
in a fire at Wal-Mart, and then claims 
that AOL will pay all of her medical 
bills if only you forward this e-mail to 
EVERYONE YOU KNOW!!! Okay, 
enough already.
Image courtesy of Snopes.com.
3.	 Bill Gates Money Giveaway 
(1997)
No, it’s true. I thought it was a scam, 
but it happened to a buddy of mine. It 
seems that Microsoft is testing some 
new program for tracing e-mail, and the 
company needs volunteers to help try 
the thing out. He forwarded me an e-
mail that he received from Microsoft—
and get this, from Bill Gates himself! 
Two weeks later, as a reward for 
1

participating, my pal received a check 
for thousands of dollars! Sure he did. 
Another version of this hoax claims 
that AOL’s tracking service is offering 
a cash reward. Tell you what—when 
you get your check, send me 10 percent 
as a finder’s fee, okay?
4.	 Five-Cent E-Mail Tax (1999)
“Dear Internet Subscriber,” the e-mail 
starts. “The Government of the United 
States is quietly pushing through 
legislation that will affect your use 
of the Internet.” It goes on to reveal 
that “Bill 602P” will authorize the 
U.S. Postal Service to assess a charge 
of five cents for every e-mail sent. 
Not a bad way to cut down on the 
number of dopey e-mail chain letters 
and lame jokes people let loose on the 
world. But credulous curse averters 
6

and connoisseurs of boffo laffs 
can relax: This e-mail alert, which 
popped up in 1999 and comes back 
for a visit every year or so, just 
isn’t true. Still, it sounded plausible 
enough to fool Hillary Clinton 
during a 2000 debate when she was 
running for the Senate.
5.	 Nigerian 419 E-Mail Scam 
(2000)
“DEAR SIR,” the e-mail starts. 
“FIRSTLY I  MUST FIRST 
SOLICIT YOUR CONFIDENCE 
IN THIS TRANSACTION; LET ME 
START BY INTRODUCING MYSELF 
PROPERLY...” I’m sure you’ve 
received one of these—a confidential, 
urgent e-mail message promising you 
a reward of mucho dinero for helping 
this person convey money abroad. All 
you need do in return is entrust your 
name and bank account number to the 
government bureaucrat (or his uncle, 
aunt, or cousin, the ostensible “credit 
officer with the union bank of Nigeria 



plc (uba) Benin branch”) who needs 
your help.

It’s the Nigerian con, also known 
as an Advanced Fee Fraud or 419 
scam (so called because of the section 
number of the Nigerian criminal 
code that applies to it). Ancestors of 
these scams appeared in the 1980s, 
when the media of choice were letters 
or faxes—and they’re still wildly 
successful at snagging people. In fact, 
Oprah recently featured a victim of the 
Nigerian scam on her show. And if you 
think that smart, educated folks couldn’t 
possibly fall for it, you’ll be surprised 
when you read “The Perfect Mark,” a 
New Yorker magazine article profiling 
a Massachusetts psychotherapist who 
was duped—and lost a fortune.

To see how the hoax works, visit 
Scamorama <http://www.scamorama.
com/bunyan.html>, a fascinating 
site that features a progression of e-
mail messages stringing along 419 
scammers, sometimes for months at a 
time. Finally, check out the 3rd Annual 
Nigerian E-Mail Conference <http://j-
walk.com/other/conf>, an absolutely 
perfect spoof.
6.	 It’s Kidney Harvesting Time 
(1996)
The subject line is laden with exclamation 
points: “Travelers Beware!!!” If that’s 
not enough to get your attention, 
the chilling story certainly will. The 
message warns that an organ-harvesting 
crime ring is drugging tourists in New 
Orleans and Las Vegas, snatching their 
“extra” kidneys, selling the organs to 
non-Hippocratic hospitals, and leaving 
the victims to wake up in a bathtub 
full of ice and find a brief note that 
explains the situation and conveniently 
identifies the phone number of the 
nearest emergency room. Hey, maybe 
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they’ll get lucky and the hospital will 
have a compatible replacement kidney 
on hand. But travelers, fear not!!! 
According to the National Kidney 
Foundation, this scenario has never 
actually occurred—though it does have 
the makings of a great horror flick. 
(Freddy’s Last Harvest, anyone?)
7.	 You’ve Got Virus! (1999 and on)
There’s isn’t a Teddy Bear virus. Nor 
is there a sulfnbk.exe or A Virtual 
Card for You (“the WORST VIRUS 
EVER!!!…CNN ANNOUNCED IT. 
PLEASE SEND THIS TO EVERYONE 
YOU KNOW!!!”).

The jdbgmgr.exe hoax (also known 
as Teddy Bear because the jdbgmgr.
exe file is represented by a teddy bear 
icon) warned recipients of the e-mail 
message that they were at risk of 
infection from a virus sent via address 
books or Microsoft Messenger, and that 
they should delete the file immediately. 
But in reality there was no virus—and 
unfortunately, jdbgmgr.exe was a 
necessary Java file. The sulfnbk.exe 
hoax nailed even advanced users with its 
insistence that the file—a legit one that’s 
used for fixing long file names—was a 
virus. Lots of people removed it.

Similarly, A Virtual Card for You 
claimed that McAfee had discovered 
a virus that, when opened, would 
destroy the hard drive on an infected 
system and would automatically send 
itself to everyone on the user’s e-mail 
contacts list. Of course, it didn’t do 
anything except scare people. So before 
you forward an e-mail virus warning 
to anyone (especially to me), look it 
up on Sophos <http://www.sophos.
com/search> or Vmyths <http://www.
vmyths.com> to make sure it isn’t a 
fraud.
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8.	 Microsoft Buys Firefox (2006)
Talk about scaring the entire open-
source community. In October 2006, 
a previously unknown Web site 
popped up, announcing Microsoft’s 
acquisition of Firefox and promoting the 
company’s new Microsoft Firefox 2007 
Professional. The site talks glowingly 
about the browser’s new features and 
provides a video advertisement for the 
product. It was a great prank, and the 
image of the Microsoft Firefox 2007 
box was so elaborate and professional 
looking that the blood pressure of real 
Firefox users went sky-high. 
Image courtesy of Snopes.com.
9.	 The Really Big Kitty (2001)
There are big cats and then there are 
even bigger cats. This one, reportedly 
tipping the scales at almost 90 pounds, 
was enormous. The claim seemed 
plausible and even snookered a lot of 
e-mail cynics (I’m raising my hand)—
until they read the accompanying 
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copy, that is. With nonsense about the 
owner working at Atomic Energy of 
Canada Limited, and more balderdash 
about nuclear reactors, the jig was up. 
Eventually, the cat’s owner fessed up to 
a creative Photoshop session, though he 
claimed that he never expected anyone 
to believe the photo was real.
10.	$250 Cookie Recipe (1996)
The woman loved the cookie she had 
just nibbled at a Neiman Marcus cafe 
in Houston, so she asked her waiter 
for the recipe. “Two-fifty,” he said, 
and she agreed without hesitation, 
instructing him to add it to her tab. But 
when the woman’s Visa bill arrived, it 
read $250, instead of $2.50. Bent on 
revenge, she proceeded to ask you to 
blast the recipe to—okay, ready?—
EVERYONE YOU KNOW!!! Like 
many hoaxes, this one predated 
the Internet, only to resurface in 
the electronic age. It appeared in a 
cookbook in the late 1940s as the $25 
fudge cake, popped up in the 1960s as 
the Waldorf-Astoria red-velvet cake 



Image courtesy of Snopes.com.
recipe, and re-emerged in the 1970s 
as the Mrs. Fields cookie recipe.
Hoaxes 11 Through 15
This group of five begins with a 
phony e-mail message promising 
money and other prizes from 
Disney, and ends with the classic 
deaf-to-reason arguments of the 
Apollo moon landing deniers.
11.	Free Vacation Courtesy of 
Disney (1998)
Dear Goofy… Forward this e-mail 
chain letter to everybody under the 
sun and, once 13,000 people have 
received it, Walt Disney Jr. will 
send five grand each to 1,300 lucky 

people on this list. And “the rest will 
recieve a free trip for two to Disney for 
one week during the summer of 1999.” 
Is that Disney World, Disneyland—or 
Walt’s house? The “Jr.” after Disney, in 
reference to a nonexistent person, ought 
to have been the first clue that this was a 
hoax. And the misspelling of “receive” 
was the clincher (remember, hoaxters, 
“i” before “e” except after “c”). Yet 
people forwarded the message around 
the world using the time-honored e-
mail chain letter adage: I’m sending it 
to you…just in case it’s true.
12.	Sunset Over Africa (2003)
Now that’s a dazzling photo of Africa 
and Europe, taken right around sunset 
from the Space Shuttle Columbia. What 
makes the image especially amazing is 
that, while London remains in daylight, 
night has fallen in Italy (a little to the 
southeast) and the bright lights of Rome, 
Naples, and Venice are blazing. Too 
bad it’s a digitally altered photo, most 
likely layered from multiple satellite 
images. To see an accurate, computer-
generated illustration, check out the 
World Sunlight Map <http://www.die.
net/earth>.
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13.	Alien Autopsy at Roswell, New 
Mexico (1995)
Roswell, New Mexico: ground zero of 
UFO controversy. It’s also where the 
movie of the Roswell alien autopsy 
was filmed 60 years ago. The story 
goes that a UFO crashed at this site, 
and the U.S. government performed a 
hush-hush autopsy on the dead alien. 
In the mid-1990s, unnamed individuals 
“discovered” the secret film and posted 
it for the edification of a disinformed 
public. Looks pretty real, right? Now 
fast-forward to 2006 and a conspiracy-
deflating admission: The movie is a hoax 
created in 1995 by John Humphreys, the 
animator famous for Max Headroom, 
in his apartment in north London.…Or 
was it???
14.	Real-Time GPS Cell Phone 
Tracking (2007)
Have you heard about the Web site 
that can track the location of your cell 
phone in real time? It uses satellite GPS 
in combination with Google Maps, and 
it’s amazingly accurate (not to mention 
a disturbing invasion of privacy). Go 
ahead, check it out yourself by going to 
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the SunSat Satellite Solutions <http://
www.sat-gps-locate.com> site and 
tracking your own cell phone’s location. 
Select your country, type in your cell 
phone number, click the Start Searching 
button, and wait for it. (This is one of 
the year’s best pranks. And I won’t give 
away the ending.)
15.	Apollo Moon Landing Hoax 
(1969)
You’re aware that we never landed 
on the moon, right? It was all just an 
elaborate hoax designed to score Cold 
War points for the United States against 
the Soviet Union in a world of falling 
dominoes. The whole lunar landing 
thing? It was a video staged at movie 
studios and top-secret locations.

Okay, you can stop laughing now, but 
some sites, such as Apollo Reality <http://
web.archive.org/web/20040609120420/
www.geocities.com/apolloreality> 
and Moon Landing <http://web.
archive.org/web/20010407065641/
thepeoplesrevolution.tripod.com/
moonlanding.htm>, still insist that 
the Eagle never landed. Of course, 
enemies of Flat Earthism will point 
to the Rocket and Space Technology 
<http://www.braeunig.us/space/hoax.
htm> site, which does an in-depth 
job of debunking the hoax. But true 
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disbelievers should check out this terrific 
video spoof <http://www.youtube.com/
watch?v=mouUUWpEec0>, complete 
with outtakes showing lights and 
cameras.
Hoaxes 16 Through 20
The world of weird eBay auction items 
starts off this page, which concludes 
with a photo hoax purporting to show a 
1950s-era vision of the home computer 
of tomorrow.
16.	Sell It on eBay! (1995)
You won’t believe what people have 
sold on eBay—some of the items 
pranks, some of them for real, and some, 
well, it’s hard to tell. For a sampling 
of the weird, you need look no further 
than a haunted tree stump and a pork 
chop shaped like a grizzly bear. The 
Internet itself once went on the market 
at a modest starting bid of a million 
bucks, as have a dozen spontaneous 
images of the Virgin Mary (on toast, on 
windows, and heaven only knows where 
else). Bidders have also had a shot at 
someone’s soul, a guy’s virginity, and 
a human kidney, with the price of this 
last item having reached $5.7 million 
before eBay pulled the plug. (Hey, guys, 
don’t you know that what you lose in 
Las Vegas is supposed to stay in Las 
Vegas?)
0

But my favorite eBay offering 
involves a tattooed guy who, as a 
joke, dressed up in his ex-wife’s 
size 12 wedding gown and put it up 
for auction. Only, the dress ended 
up selling for $3850, and the guy 
got five marriage proposals. Nice.
17.	Chinese Newspaper Duped 
(2002)
Information on the Internet may 
want to be free—but if it’s posted 
by a for-profit publisher, you’d 
better take it with a grain of salt. 
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That’s the lesson learned by China’s 
Beijing Evening News, which was taken 
in by the Onion’s Capitol Dome spoof. 
Famous for its authentic-sounding but 
tongue-in-cheek articles steeped in the 
language of the Associated Press, the 
Onion <http://www.theonion.com> 
reported that Congress had threatened 
to leave Washington, D.C., and head 
for Memphis unless the District agreed 
to erect a new domed Capitol building 
with a retractable roof and luxury box 
seating. Having accepted most of the 
Onion article at face value, the Chinese 
newspaper at first stood by its source 
in the face of international derision 
and refused to back down. When it 
finally published a retraction, it blamed 
the Onion for the confusion: “Some 
small American newspapers frequently 
fabricate offbeat news to trick people 
into noticing them with the aim of 
making money.” Right.
Image courtesy of Snopes.com.
18.	The Muppets Have Not Already 
Won (2001)
In early October 2001, just prior to 
the U.S. invasion of Afghanistan, 
protesters at an anti-American rally 
in Bangladesh showed their support 
for Osama bin Laden by marching, 
chanting, and waving placards. One 
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of the posters captured on film by 
Reuters News Agency was a photo-
montage of the Al-Qaeda leader, 
and in one of the shots a yellow felt 
puppet to his right glowers furiously 
at the camera. It’s…Bert of Sesame 
Street. Originally a Zelig-inspired 
creation of San Francisco Webmaster 
Dino Ignacio, the satirical Web site 
Bert Is Evil <http://www.bertisevil.
tv> depicted Bert hobnobbing with 
the worst of the worst in history, 
tormenting his roommate Ernie, and 
generally reveling in wickedness. 
After Ignacio retired from active 
efforts to expose Bert’s career of 
evil, others filled the Photoshop void, 
capturing the cone-headed miscreant 
with all the latest baddies-du-jour.

Evidently, the company responsible 
for printing the pro-Osama poster 
found the doctored dual portrait 


irresistible, although (according 
to the Urban Legends References 
Pages <http://www.snopes.com/
rumors/bert.htm>) its production 
manager claims to have produced 
about 2000 copies of the Osama-
and-Bert poster without realizing 
“what they signified.” Well, if you 
can’t trust pictures you find on the 
Internet, what can you trust?
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19.Chevrolet’s Not-So-Better Idea 
(2006)
The ad folks at Chevrolet thought they 
had a winner: Let site visitors create 
their own 30-second commercial for 
the company’s 2007 Chevy Tahoe SUV. 
It’ll be fun, they probably thought. 
We’ll give them a choice of video clips 
and soundtracks, and let them add their 
own text captions. Yep, viral marketing 
at its best.

Unfortunately for Chevrolet, a few 
pranksters decided to use the opportunity 
to express what they thought of the 
SUV. One commercial said, “Like this 
snowy wilderness? Better get your 
fill of it now. Then say hello to global 
warming.” Another lambasted the SUV 
as a gas guzzler: “Our planet’s oil is 
almost gone. You don’t need G.P.S. to 
see where this road leads.”
20.	Rand’s 1954 Home Computer 
(2004)
This intriguing image of a room-size 
computer made the rounds of the 
Internet, accompanied by a breathless 
blurb: “This article is from an issue of 
1954 ‘Popular Mechanics’ magazine 
forecasting the possibility of ‘home 
computers’ in 50 years.” The steering 
wheel in the picture is the predecessor to 
today’s mouse, and the keyboard looks 
like those on teletype machines. It even 
comes complete with a guy right out of 
the Eisenhower era.

Cool stuff, and easy to believe—but 
it’s not a 1950s Rand Corporation 
mockup of what a prototype home 
computer might look like. It’s actually 
a shot that was taken of a submarine 
display at the Smithsonian Institution 
and subsequently modified for inclusion 
in a Fark.com <http://www.fark.com> 
image-manipulation competition.
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Hoaxes 21 Through 25
Our final five takes you from the 
ultimate instance of Microsoft hubris 
to an ill-conceived experiment in 
Internet democracy (or is that Internet 
anarchy?).
21.	Microsoft Buys Catholic Church 
(1994)
More than a decade ago, an e-mail press 
release—from Vatican City, no less—
landed in my inbox. Microsoft was 
announcing that it was in the process of 
acquiring the Roman Catholic Church 
in exchange for an unspecified number 
of shares of Microsoft common stock. 
The story was a prank, but it sure looked 
real, circulating for months and perhaps 
worrying residents of the Holy See. 

Just think: If the press release had 
been true, it might have stopped the 
Vatican from using Linux. And no, I’m 
not kidding about the Linux part. Watch 
this video interview <http://scobleizer.
com/2007/02/19/the-geeky-sister-
behind-vaticans-website> with the 
woman who helped build the Vatican’s 
Web site.
22.	Hercules, the Enormous Dog 
(2007)
Wow, that dog’s almost as big as the 
horse. That’s what I thought when I 
first looked at this e-mail. The picture 
depicts a couple, one walking a horse, 
the other holding the leash of Hercules, 
a 282-pound English Mastiff and “The 
World’s Biggest Dog Ever According to 
Guinness World Records.”

Horsepucky. Here’s my analysis of 
the Photoshop modifications. First, take 
a close look at the grass under the people 
and the animals. The area has been 
subtly lightened in order to make all of 
the shadows match and look authentic. 
Next, examine the shadows and you’ll 
notice two anomalies: First, the shadows 
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of the dog and the man start at their feet, 
but the same doesn’t hold true for the 
horse. Second, the woman’s shadow is 
missing altogether; instead, the man’s 
shadow extends in front of her. Oh and 
by the way, the Guinness World Records 
site doesn’t have a listing for Hercules 
or for the world’s biggest dog. Okay, 
okay, so the pictures of the big kitty and 
the big dog are both fakes—but have 
you seen the shot of Craig Sherwood 
riding the world’s largest jackelope?
23.	Lights-Out Gang Member 
Initiation (1998)
People have a tendency to believe 
e-mail messages that come from 
authority figures. In 1998, a 
message purportedly from a police 
officer working with the DARE 
program circulated around the 
Internet. It warned recipients 
not to flash their lights to inform 
oncoming cars that their headlamps 
were off. According to the message, 

a recently devised gang initiation ritual 
involved having new gang members 
drive at night with their headlights 
turned off until an oncoming car 
flashed its lights at them; then, in order 
to become initiated, they were to shoot 
everyone in that car. It’s just another 
urban myth—and about as silly as the 
one claiming that gangs mark off their 
23
territory by hanging sneakers from 
power lines.
24.	Hurricane Lili Waterspouts 
(2002)
It’s weird, it’s disturbing, and it’s 
seemingly plausible—all of the 
elements necessary for a successful 
e-mail forward. The image shows three 
dark waterspouts in the distance. The 
subject is “here comes lili,” and the 
e-mail began appearing in inboxes at 
about the same time that Hurricane 
Lili started battering the Louisiana 
coastline. But three waterspouts, 
all neatly lined up? According to 
About.com, the National Weather 
Service labeled the picture a hoax 
and said that it was a modification 
of a genuine photo taken in 2001 
by a crewmember of the Edison 
Chouest Offshore supply boat 
“C‑Rambler”.
25.	 Pranks Shut Down Los 
Angeles Times Wiki (2005)
It seemed like a bright idea. The LA 
Times’ “A Wiki for Your Thoughts” 
fandango asked readers to chime in on 
the newspaper’s editorials via a Wiki. In 
their explanation of how it would work, 
the editors even acknowledged that “It 
sounds nutty.” Yet they went ahead with 
it—and achieved disastrous results. 

http://www.About.com


The Wikitorial (the name was nearly as 
dumb as the scheme) brought out the 
best and then the worst in readers. On 
the first day, an editorial about the war 
in Iraq prompted civil and thoughtful 
contributions. On day two, pranksters 
littered the unmoderated Wiki with 
rude comments, pornography, and 
profanity. The Webmaster removed the 
offending entries, but only after they 
were available for public viewing. By 
the next morning, the publisher had 
dismantled the Wiki.

Copyright 2007 Steve Bass and PC 
World. This column originally appeared 
on PC world online. Read Bass’s blog 
at <http://snurl.com/BassBlog> and his 
previous newsletters and print columns 
at: <http://snipurl.com/tweaks>. 
Subscribe to his weekly newsletter at 
<http://snurl.com/homeoffice>.

Steve Bass <Stevebass(at)earthlink.
net> is a Contributing Editor with 
PC World, a 23 year veteran of 
PIBMUG, and a founding member of 
APCUG. He’s also the author of PC 
Annoyances: How to Fix the Most 
Annoying Things about Your Personal 
Computer, O’Reilly Press. It’s still 
available on Amazon at dirt-cheap 
prices. <http://snurl.com/annoy2>.

This article has been provided 
to APCUG by the author solely for 
publication by APCUG member 
groups. All other uses require the 
permission of the author (see e-mail 
address above).
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There are 10 types 
of people—those who 
understand binary 
and those who don’t.
Obtained from APCUG with the 
author’s permission for publication by 
APCUG member groups.

Previous versions of Windows 
always accepted an installation disk 
as proof you had a legitimate copy of 
Windows. This entitled you to install the 
upgrade version of the latest release of 
the operating system. Vista doesn’t work 
the same way. The only thing it will 
recognize is a copy of Windows already 
installed on a hard drive. Why Microsoft 
did this remains a mystery, but perhaps 
there really are things that mere mortals 
are not meant to know. 

Don’t go out and splurge on a full 
version of Vista. Read on and save some 
money. There are four primary versions 
of Vista: 
Vista Home Basic
Vista Home Premium
Vista Business
Vista Ultimate

The difference between the full and 
upgrade versions of each variation of 
Vista ranges between $72 and $155. 
Even though Vista is a big improvement 
over XP, why spend the extra money for 
a full version if you don’t have to? 

If you’re attempting to upgrade from 
a version of XP or Windows 2000 that’s 
already installed on your hard drive, the 
upgrade version of Vista will install as 
soon as it recognizes the older version of 
Windows on your system. However, if 
you’ve formatted your hard drive, Vista 
refuses to accept an installation disk 
from a previous version of Windows 
as evidence that you do indeed own a 

Windows XP Upgrade 
to Vista 

By Vinny La Bash
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legitimate copy of Microsoft’s flagship 
product. 

Fortunately, there is a legitimate 
method to work around this otherwise 
severe and unnecessary restriction. 
There is an undocumented procedure 
that allows you to do a full clean install 
of Vista to a physical hard drive without 
a previous version of the operating 
system installed. 

The setup program in the Vista 
upgrade is the tool that lets you perform 
a full clean install of the product. In 
addition to XP and Windows 2000, 
Vista will recognize a copy of itself 
that has not yet been activated. What 
if we install Vista twice? We are going 
to install Vista, and then “upgrade” 
to Vista. Before you do ANYTHING, 
please read the entire 20 step procedure 
first. I’ll wait while you do this. OK, 
let’s get started. 
1.	 Boot your PC from the Vista DVD.
2.	 In the dialog box that comes up 

select “Install Now.” DO NOT enter 
the product key at this time. You’ll 
do that later. 

3.	 Turn off the option that says 
“Automatically activate Windows 
when I’m online.”

4.	 Another dialog box comes up. 
Confirm the Vista installation 
without the product key. 

5.	 Tell the installation program what 
version of Vista you’re installing. 
Don’t fib about this.

6.	 This step is important. Select the 
“Custom (Advanced)” install, NOT 
the “Upgrade” install. 

7.	 Wait for the install program to copy 
files. Your system will probably 
reboot several times. Don’t touch 
anything. Let the install complete.

8.	 Eject  the instal lat ion DVD 
WITHOUT activating Vista. 
2

9.	 Reboot to make sure everything is 
working OK.

10.	Reinsert the Vista installation disc 
and run setup again.

11.	Click “Install Now.”
12.	Select “Do not get the latest updates 

for installation.” You can do that 
later. 

13.	Enter the product key.
14.	Turn off the option to “Automatically 

activate Windows when I’m 
online.” 

15.	Now select “Upgrade,” not “Custom 
(Advanced).” This is where you do 
the actual “upgrade” to Vista. 

16.	Pay attention! Don’t do anything 
while the setup program copies files 
and does a reboot. 

17.	At some point the system will ask 
if you would like to boot from the 
DVD. Decline the invitation. 

18.	No matter what happens on the 
screen, leave the keyboard and 
mouse alone. Resist the urge 
to do something. Vista setup is 
making all the right choices for you 
automatically. 

19.	The Thank You dialog box will 
eventually appear. Click Start.

20.	Vista’s login screen will come up 
shortly. Enter the user name and 
password you created during the first 
installation. 
Congratulations! You’re finished 

upgrading to Vista, but you still have 
a housekeeping chore to perform. You 
have to activate Vista within 30 days 
of installation or it will cease working 
properly. To activate Vista:
1.	 Reboot your machine.
2.	 The Welcome Center appears. 
3.	 Click “Show more details.” 
4.	 Click “Activate Windows” now. 
5.	 Activation will now take place 

automatically over the Internet. 

5



It is unknown why Microsoft 
programmed this procedure into the 
setup program. My conjecture is that 
the procedure was implemented for 
the convenience of programmers 
while testing the product and someone 
decided that it was too much trouble to 
remove. Another possibility is that when 
Microsoft management gave the order 
to stop development and concentrate on 
fixing bugs, there was no time to remove 
the feature before product release. 
Whatever the case may be, let’s use 
Microsoft’s perhaps unintentional gift 
to save a few bucks. 

Vinny LaBash is a member of the 
Sarasota PCUG, Florida <http://www.
spcug.org> and may be reached at 
<labash(at)spcug.org>

This article has been provided 
to APCUG by the author solely for 
publication by APCUG member 
groups. All other uses require the 
permission of the author (see e-mail 
address above).
Obtained from APCUG with the 
author’s permission for publication by 
APCUG member groups.

This article is being written in the 
Linux version of Open Office 2.0 on 
a computer that uses Ubuntu as the 
operating system (OS). Since this 
system is now networked with my 
Windows XP computers, both desktop 
and laptop, I can easily transfer files 
between the computers. I am also able 
to print from this Linux computer to 
my laser printer over the Windows 
network. So what did I have to do to 
accomplish this?

Vista Alternatives 
Part II 

By Brian K. Lewis, 
Ph.D.
2

The first thing I had to do was to 
install a copy of Samba on this Linux 
computer. Ubuntu has an Add/Remove 
graphic interface for the Synaptic 
Package Manager. This has a one-click 
download install for new applications. 
The Samba package that was installed 
had a GsambaD graphic front end. 
This turned out to be very frustrating 
as it insisted I had to be logged in as 
Root to run the application. Now with 
most Linux versions this would be a 
simple change of user. Root is usually 
the designated Administrator and is 
the only user allowed to alter system 
files and add/remove software. There 
is also a user that has fewer privileges. 
(Sounds somewhat like Vista, doesn’t 
it?) However, in Ubuntu, the user is 
also the administrator. To carry out any 
functions that require administrator 
privilege, the OS asks for the password. 
The idea being that only one password 
is required for the user to remember. 
Anyway, the GsambaD software 
refused to acknowledge that I was 
the administrator and didn’t ask for a 
password, it simply shut down after 
presenting me with the error message.

The next step was to manually 
edit the samba configuration file. I did 
have to do some searching through 
the Ubuntu on-line forum in order to 
find some help on the lines I needed 
to edit. It also required some facility 
with the command line mode (terminal) 
in Ubuntu. Obviously, if you are not 
comfortable making these types of 
changes, this OS are not for you. Until 
Ubuntu is able to install peripherals and 
local networking functions as easily as 
does Windows, it will not attract a truly 
large following.

So after making the configuration 
changes and re-booting the system, I 
6
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went to the Places → Connect to Server 
menu. Immediately on clicking on that 
line, an icon was placed on the desktop 
and a window opened up showing the 
shared folders on my WinXP computer. 
I had no problem pulling up data files 
or PDF files and reading them. On my 
Windows computer, I also found a 
new icon in the “My Network Places” 
folder. This was the icon for the Ubuntu 
computer. Here I was also able to 
read the folders and located data files 
that could be opened on the Windows 
computer. So the file sharing was 
successful.

My next complication was to setup a 
network printer. This had not worked in 
any of my previous attempts. Now that I 
was definitely connected to the Windows 
network, I tried again. Going to System 
→ Administration → Printing brought 
up a window with an Add Printer icon. 
This time by following the instructions 
in each window, I was able to install 
my networked laser printer. When 
I indicated that I wanted to install a 
networked printer there were a series of 
windows to go through. I had to change 
the designation from a CUPS printer to 
a Windows (SMB) printer. Then using 
the drop-down list, I was able to select 
the name of the Windows computer. The 
next line also had a drop down list and I 
was able to select the name of the laser 
printer. The list did show both of the 
networked printers. The most difficult 
part of the printer install was locating 
the device driver file. First, I had to 
select the manufacturer and the printer 
model. Then I was asked to locate the 
PPD driver file. I had to go back to the 
file management search function to 
find the folder where the driver files 
are located. Search is located at the 
bottom of the Places menu. The folder 
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turned out to be at the end of this path: 
File system-usr → share → ppd. Yes, 
the folders in Linux have names that 
are not always straightforward. It takes 
some getting used to the differences. 
Once that was done, the last window 
asked for a description and a location. 
For the location, I typed in the name of 
the Windows computer. Once back at 
the Add Printer window the laser printer 
icon appeared. Then I right-clicked, 
opened Properties and did a test print. 
The test print came through much faster 
than it did when I had tried printing 
from Windows Vista. So at least I had 
one printer that I could use with the 
Ubuntu OS.

The next thing I wanted to test was 
using a dual boot setup. I had Windows 
Vista installed on this computer but the 
changes to the boot menu to allow a 
choice of booting Vista didn’t work. So, 
I tried another tactic. I installed the latest 
version of Linspire. After its installation 
I rebooted the system and ended up back 
in Ubuntu. So, after using the Linspire 
CD to force the boot from the Linspire 
partition I printed out the Linspire 
loader file. Then I used that information 
to edit the Ubuntu loader. I added five 
lines of code that I had copied from the 
Linspire loader file. After saving the file, 
I rebooted the computer and brought up 
the boot menu. Linspire was listed as 
the first application in the list. Pressing 
return selected this item and Linspire 
loaded. So now, I had a dual boot system 
with Linspire and Ubuntu.

One of the first things I accomplished 
in Linspire was installing the network 
printer. Linspire automatically installed 
Samba so I didn’t have that to do. In the 
graphic printer installation, I was able 
to select a network printer as the type. 
Next, I provided the network name; the 



server name and the application found 
my networked printers. After that, it was 
simply a process of letting the installer 
find and install the printer driver and run 
a test print. I still don’t have my inkjet 
connected to either Linspire or Ubuntu. 
That will be another project.

Finally, I checked on the networking 
ability of Linspire. It found my Windows 
XP computer with no problems. Then 
I had to figure out how to list the 
Windows folders I wanted to show in 
the Linspire file manager. Every time 
I tried to bring up the Windows “My 
Documents” folder, it would appear 
to be empty. Since I knew that wasn’t 
correct I went back into the Linspire 
Network Share Manager and tried to 
figure out the problem. When I would 
put in the folder name, I would get a bad 
share name error. So then, I made the 
entire Windows C drive shareable. That 
worked but I still couldn’t get any files 
or folders listed under my user name. I 
tried using the Windows user name and 
password but that didn’t work either. 
Finally, I used the Admin user name and 
password and that worked! Now I can 
browse all of the folders and files in the 
Windows “My Documents” folder. The 
Linspire “My Documents” folder also 
shows in the “My Network Places” on 
the Windows computer. So, I can now 
move files and folders either direction 
on my local network. The final network 
setup was to connect my laptop to the 
wireless network and see if it was visible 
in Linspire. The laptop immediately 
found the Linspire computer and I was 
able to transfer a number of files with 
no difficulty. However, I did have to 
first provide the Administrator name 
and password.

After playing with Linspire for 
a time I went back to Ubuntu. Most 
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Linux distributions don’t come with any 
anti-virus software. Both Linspire and 
Ubuntu do include a built-in firewall. 
So, I wanted to add an anti-virus. Since 
my Windows anti-virus of choice is 
Avast I checked their web page first. 
They do have a Linux version of their 
free home edition and it was a Debian 
package. Both Linspire and Ubuntu 
are Debian based versions of Linux. 
This, again, is one of my preferences 
as I find it easier to obtain and install 
software packages based on Debian. 
So, I downloaded the Debian version 
of Avast. Clicking the install package 
Ubuntu brought up a menu asking if 
I wanted to install the package using 
“Gdebi Package Installer” and I clicked 
on OK. The installation took no time at 
all, but I couldn’t find Avast on any of the 
menus. So, I went to the Avast forum on 
the web and looked through some of the 
Linux questions. Not surprisingly, there 
were a number of questions related to 
installation on Ubuntu systems. I found 
a command line entry fairly quickly. So 
I copied it and pasted it into a Terminal 
window. That put an Avast icon in the 
Applications → Accessories menu. 
The next problem was when I clicked 
the icon it immediately asked me for a 
license key. I had found a comment in 
the forum that you could use a Windows 
Avast key for the Linux installation. 
Since I had a license key that I obtained 
for Vista that I was no longer using, 
I typed it in, pressed Enter and Avast 
came up in the graphic interface. With 
one click I did an update on the virus 
database. Then with another, I started 
a full system scan. So, Avast is now 
protecting my Ubuntu installation. 

There was another application that I 
wanted to install on the Linux systems. 
This is Picasa, a photo editing and 
8



organizing application. It is produced 
by Google and is another example of 
quality freeware. I use it for downloads 
from my digital camera, for photo 
editing and for e-mailing photos. Picasa 
automatically compresses photos for 
e-mailing. For Linspire I was able to 
find Picasa in the Click-n-Run (CNR) 
warehouse. So, that was a single click to 
have it downloaded and installed on the 
hard drive. In Ubuntu I had to go to the 
Picasa web site and find the download 
page and select a Debian version. Once 
it was downloaded I double-clicked it 
and Gdebi installed it just as had been 
the Avast. In both OS’s I found that 
Picasa worked just as cleanly as it did 
under Windows. Incidently, both Linux 
OS’s identified and installed my USB 
card reader as soon as I plugged it into a 
USB port. That will make downloading 
photos from my camera as easy as it is 
in Windows.

So why have I spent so much time 
playing with these Linux systems? It 
is mainly because I see them as viable 
competition for Windows. Granted 
there is a learning curve to getting these 
systems running on a computer. But, 
that is true whenever you install any new 
software application. However, I believe 
that Linspire and Ubuntu have come a 
long way toward meeting the needs of 
Windows users. There is a wide variety 
of software available for these Debian 
versions of Linux and the download-
install functions have been quite 
simplified. In some respects adding 
software to either Linspire or Ubuntu 
is simpler that installing software under 
Windows. It is only in rare instances that 
you have to reboot your Linux system 
after installing a new application. 
The graphic interface of both of 
these Linux versions has improved 
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to the point that most Windows users 
would have no difficulty in making 
the transition. The major problem is 
finding drivers for peripherals. I think 
this is a real stumbling block for some 
users who might like to change from 
Windows. Because of this problem, I 
can’t recommend either OS for novice 
users, only for those willing to do some 
web searching when they can’t find 
drivers for their printers, scanners or 
other devices directly through the OS 
software.

I do have several remaining questions 
on my use of Linspire and Ubuntu. The 
first is solving my problem with a driver 
for my Canon printer, possibly replacing 
it. The second is seeing if some of my 
Windows software can be run on either 
system. There are several applications 
that allow Windows software to be 
run under a Linux OS. One is called 
WINE and the other is CrossOver Linux 
sold by CodeWeavers <http://www.
codeweavers.com>. WINE is a free 
application <http://www.winehq.org> 
and CrossOver Linux sells for either 
$39.95 or $69.95. So, in the next few 
months I will continue my adventures 
with both Linspire and Ubuntu. You 
will see an occasional Linux article 
whenever I come across something that 
I think might be of interest to Windows 
users looking for alternatives. As for me, 
I intend to gradually transition all of my 
work to Linux. 

Dr. Lewis is a former university 
& medical school professor. He has 
been working with personal computers 
for more than thirty years. He can be 
reached via e-mail: <bwsail (at) yahoo 
dot com>.

This article has been provided 
to APCUG by the author solely for 
publication by APCUG member 
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groups. All other uses require the 
permission of the author (see e-mail 
address above).
The New, the Best, and 
the Worst—May 2007 

By Pim Borman

Google – The Rest of the Story
[Since the original publication of this 
article Google has changed its main 
Web page. The “more” button is now on 
the menu bar and the drop-down menu 
does not list all the features described 
in this article, although they are still 
available. The easiest way to find all 
the Google services is to do a Google 
search on “google.” It yields more 
than 40 direct references to Google 
offshoots.—Pim B.]

If you only use Google the way I 
do, using keywords to search the Web, 
you’re like the polar bear walking on 
top of an iceberg, ignorant of all that’s 
underneath. As scientists are finding out 
in the Antarctic, there is an awful lot to 
be learned from drilling down into the 
ice below, and there is a lot to be learned 
by drilling down in the Google menus. 
Go to <http://www.google.com>, click 
on more… and in the pop-up window 
click on even more… and you’ll find a 
page full of links to Google offshoots. 
I’ll just list some of them here, as space 
permits, but you may want to go see 
for yourself.

Google News <http://news.google.
com> presents a current news update 
worth being bookmarked for a quick 
check on what’s going on in the 
world. Google Finance <http://finance.
google.com/finance> has all the latest 
financial news. Google Alerts <http://
www.google.com/alerts> sends e-mail 
updates on the topics of your choice. 
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Monitor a developing news story, get 
the latest on a celebrity or event, or keep 
tabs on your favorite sports teams. This 
site is still in beta.

Froogle <http://froogle.google.com> 
is the place to go for online shopping. 
If you like to browse through catalogs, 
go to Google Catalogs <http://catalogs.
google.com>. Find local businesses as 
well as directions for getting somewhere 
with Google Maps <http://maps.google.
com/maps>. Use Google Checkout 
<http://google.checkout.com> to set up 
a Google account with which you can 
order from many participating stores 
and be protected against online fraud.

Search a variety of printed matter 
with Book Search <http://books.
google.com>, covering the full text 
of books, although many publishers 
refuse Google permission to put the 
content of their books online. Scholarly 
publications are available in Google 
Scholar <http://scholar.google.com>, 
but many of the publications at best only 
provide an abstract to non-subscribers. 
Sometimes you may be able to get 
access to the complete articles through 
the Web site of your local library, such 
as the Evansville-Vanderburgh Public 
Library. Over 7 million US Patents can 
be searched with Google Patent Search 
<http://www.google.com/patents>. 

Google Images <http://images.
google.com> lets you search for images 
that include a title, description, or 
keywords. To come up with descriptions 
for unlabeled images Google uses 
an online game, Google Image 
Labeler <http://images.google.com/ 
imagelabeler>. Two separate contestants 
are shown a picture and asked to come 
up with descriptive labels. For each 
label, they provide in common they earn 
points. It is an addictive game with the 
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benefit that the resulting winning labels 
are accurate descriptions of the image. 

For general searches, use the 
Google Directory <http://www.google.
com/dirhp> that organizes the Web by 
topic into categories. And if you have 
a problem locating stuff on your own 
computer drives, Google Desktop 
<http://desktop.google.com> will help 
you find it.
Other Features
Google has been extending its services 
beyond searching. GMail <http://mail.
google.com> offers online e-mail 
accounts with many features and 
very large mail storage areas (several 
gigabytes as of this writing). Docs and 
Spreadsheets <http://docs.google.
com> offers an online word processor 
and spreadsheet program that facilitates 
project cooperation between groups 
of persons. Additional cooperative 
programs are Calendar <http://www.
google.com/calendar>, to organize 
your schedule and share events with 
friends, and Groups <http://groups.
google.com> to create mailing lists and 
discussion groups. 

With Talk <http://www.google.
com/talk> you can IM and call your 
friends through your computer. You can 
also use Blogger <http://www.blogger.
com> to create a shared online diary. 
Picasa <http://picasa.google.com> lets 
you edit, organize and share your photos 
with others, while YouTube <http://
www.youtube.com> lets you watch, 
upload and share videos.

Google Earth <http://earth.google.
com> is in a category of its own. It lets 
you roam all over the earth and zoom in 
on specific areas of interest. 

If you want to know what else 
Google may come up with visit Google 
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Labs <http://labs.google.com> for a 
preview.
Rebates With Manners?
I recently purchased a copy of Adobe 
Photoshop Elements. It came with a $20 
upgrade rebate offer for which almost 
any photo-editing program, including 
Picasa2, passed muster. I sent in the box 
tab with a Xerox copy of my old MS 
PhotoDraw disc and the invoice. To my 
surprise, I received an e-mail, several 
days later, acknowledging receipt of 
my submission. A week later, I received 
a notice that “Your rebate check was 
mailed on 09-Apr-2007. Please allow 
at least 30 days for delivery.” So far, so 
surprisingly good. I received the check 
on April 25, not bad for, maybe, surface 
mail from India. 
Super Internet Creation?
Many newspapers carried an Associated 
Press article by Anick Jesdanun, dated 
April 14, 2007, about movements afoot 
to create a new and improved Internet 
from scratch to replace the current one. 
As the article states, “...many believe 
a clean slate approach is the only way 
to truly address security, mobility and 
other challenges...” For some time 
this has been the dream of university 
researchers trying out new concepts, 
but now “Industry is playing a bigger 
role this time, and law enforcement is 
bound to make its needs for wiretapping 
known.” Sounds ominous.

The National Science Foundation is 
sponsoring several projects toward the 
goal of establishing an experimental 
network known as the Global 
Environment for Network Innovations, 
or GENI. Major universities are 
involved, as well as the Defense 
Department. The European Union has 
its own independent efforts underway.
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The current Internet and its World 
Wide Web superstructure, with all its 
shortcomings, is a truly wonderful 
achievement. Twenty years ago, no 
one in his wildest dreams could have 
foreseen the worldwide scope and 
the extent to which it has become 
an integral part of our civilization. It 
demonstrates how natural evolution 
can achieve the unthinkable. And 
that should now be replaced by a 
politically correct product, created 
by committees of programmers and 
approved by international governments 
and “industry”? Lord help us. Let’s stick 
with evolution.

(If you want to read the original 
article use Google to search for 
“Jesdanun Associated Press”. Thanks 
to Linda Gonse, editor of the Orange 
County PCUG, for bringing the article 
to my attention.)

© 2007 Willem F.H Borman. This 
article may be reproduced in its entirety 
only, including this statement, by non-
profit organizations in their member 
publications, with mention of the 
author’s name and the Southwestern 
Indiana PC Users Group, Inc.

Pim Borman is a member of the SW 
Indiana PC Users Group, Inc
Irfanview 4.0 
Freeware Image Editor 

and Media Player
By Ira Wilsker

Imagine a free (for non-commercial 
use), full featured utility that can 
display and edit almost all known image 
formats, and convert from any one 
format to any other. Imagine a utility 
that can play almost every known audio 
and video format with its free “Plugins” 
file, all in a small and very efficient 
software package. Some skeptics may 
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say that this sounds too good to be true, 
but lucky for us, it is indeed true. The 
program that can do all of the above, 
and more is the very popular Irfanview, 
version 4.0 <http://www.irfanview.
com>, written by a Bosnian named Irfan 
Skiljan. This outstanding program is 
not a well known secret, as the popular 
download site <http://www.Download.
com> alone reports over 26 million 
downloads of Irfanview (including 
previous versions), with probably tens 
of millions of copies downloaded from 
countless other download resources, 
and over a million additional copies 
downloaded every month.

People send me several e-mails every 
day with images or videos attached, 
and I have Irfanview set as my default 
viewer and player for almost all images, 
audio files, and videos. Using Irfanview 
is fairly simple, straight forward, and 
somewhat intuitive. After downloading 
<http://www.irfanview.com> and 
installing the file, I recommend that 
the companion file “Irfanview Plugins” 
also be downloaded and installed. After 
installing the “plugins” the user is 
given the option to selectively choose 
Irfanview as the default for any or all 
of the file extensions it supports. It may 
not be a bad choice to allow Irfanview 
to be the default for those extensions, 
but the decision can be reversed if 
decided later.

One frequent function that I use 
Irfanview for on a regular basis is 
image editing. Recently, a relative sent 
me several unedited JPG digital photos 
of her new puppy taken at maximum 
resolution with a 6 megapixel digital 
camera. Each image was huge both 
in file size (several megabytes), and 
in viewing size. I have a big-screen 
monitor running at a high screen 
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resolution, and still could not view 
the entire image without scrolling, as 
the image size was greater than my 
monitor resolution. Since I opened the 
attached images in Irfanview, it was but 
a few mouse clicks to edit them down 
to a more manageable size; I clicked 
on IMAGE → RESIZE/RESAMPLE 
and then selected a percentage of the 
original size, and then saved the image 
in its reduced size. It is good netiquette 
to reduce the size of multi-megapixel 
images, and then e-mail the digital 
images in a more reasonable size such as 
800x600 or 1024x768. [If the recipient 
is likely to want to print a large high-
resolution copy of the image, sending it 
at full resolution may be desirable, but 
for screen viewing, lower resolution 
should be preferred. —Ed.] It is also 
good netiquette to crop the image, 
which can be done simply by clicking 
and holding the left mouse button on a 
corner of the desired image, and then 
dragging it in a frame to the desired 
borders of the cropped image. EDIT 
→ CROP SELECTION will instantly 
produce the cropped image which can 
be saved or further edited.

Another purpose of Irfanview is to 
improve the quality of digital images 
by enhancing the colors. The command 
IMAGE → ENHANCE COLORS 
opens a dual pane window that shows 
the unedited original image and the 
new image with the changes applied. 
Possible changes that can be made 
include brightness, contrast, color 
balance, gamma, and saturation. By 
using a slider or manually entering 
values allows the user to see the 
effects of any changes before saving 
the edited image. Another selection I 
often utilize is the “sharpen” command 
on the image menu; this automatically 
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sharpens a fuzzy image. Other image 
commands include red-eye reduction, 
and a panorama function where separate 
images can automatically be knit 
together to make a larger panoramic 
image.

Readers of this column will notice 
that sometimes images are displayed 
along with the text. Most of these 
images are screen captures made with 
Irfanview. By selecting OPTIONS → 
CAPTURE/SCREENSHOT a hot key 
is then used to capture the image on 
the monitor. I use the default hotkey 
(Ctrl-F11) for image capture, crop the 
image as desired, and then save it in the 
desired format.

While there are many other image-
editing features included in the program, 
Irfanview also shines as an audio and 
video player if the plugins are installed. 
Popular audio formats, such as MP3, 
RA, and WAV are fully supported, 
allowing this single program to play 
almost any audio format, with full 
control of volume and other technical 
details. There are many video formats 
in common use, such as MPEG, AVI, 
and WMV that are often used for the 
videos that people e-mail or display on 
a webpage, and Irfanview can handle 
almost all of them interchangeably, 
and can serve as an able substitute 
for Windows Media Player, and most 
other media players. Audio and video 
on CDs and DVDs can also be played 
with Irfanview.

Irfanview 4.0 will work well on all 
versions of Windows from 95 to Vista, 
and is simple enough for beginners, and 
sophisticated enough for professionals. 
The software is free for non-commercial 
use, and the author encourages purely 
voluntary contributions via PayPal. 
I suggest that readers of this column 




download it and try it. There is no 
adware or spyware embedded in it, and 
the program has a clean and uncluttered 
interface. I have personally used 
Irfanview on an almost daily basis on 
all of my computers for several years, 
and can strongly recommend it. Try it, 
and you may end up liking it as much 
as I enjoy Irfanview.
WEBSITE
<http://www.irfanview.com>

Ira Wilsker is an APCUG director; 
Columnist, The Examiner, Beaumont 
TX; Program Director of Management 
Development at the Lamar Institute 
of Technology, Beaumont TX; and a 
radio & TV show host. Contact him at 
<iwilsker@apcug.net>.
Build It Yourself 
By Brian K. Lewis, 

Ph.D.

Obtained from APCUG with the 
author’s permission for publication by 
APCUG member groups.

You may never have considered 
building your own computer, but it is 
really just an assembly job. When you 
are familiar with the components of 
your system, you will find it is easier 
to understand and possibly diagnose 
problems. A couple of weeks ago I had 
the opportunity to assemble two new 
computers for one of my children. She 
needed two additional systems for the 
growing work force in her business. I 
had forgotten how much fun it is to put 
a new system together. So, I thought 
I would share some of the reasoning 
behind the selection of the components 
and assembling them into a working 
product. Even if you don’t build a new 
computer, it might be useful the next 
time you are looking for a new system.
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For these computers it was not 
necessary that they be “state of the art,” 
so I selected an Intel Celeron D central 
processor (CPU). These CPUs function 
quite well, especially at the 3.2 Ghz 
speed. Since they were intended for 
a specific office environment the 
price point and the speed were ideal. 
However, Celeron processors do not 
support dual-threading nor are they 
dual-core processors. If you want the 
latest in processors then you should 
consider the Intel Core-2 Duo or 
an AMD dual processor. Another 
alternative would be to use a 64-bit 
processor instead of these 32-bit 
processors. The main drawback to that 
is that most software isn’t really ready 
to take advantage of 64-bit processing 
and there are still problems with some 
drivers for peripheral equipment.

Once I decided on the CPU, the 
next step was to find an appropriate 
motherboard. I selected an Intel 
946 series with the 775 socket. This 
motherboard supports Intel processors 
from the Celeron D to the Core-2 
Duo. This makes it a good choice for 
any upgrades to another CPU. It also 
supports up to 4GB of RAM. This 
board also features built-in sound 
and video. Naturally that has both 
pros and cons associated with these 
features. With the integrated video 
you can run Windows Vista in the 
mode which uses the “Aero Glass” 
graphics because it borrows memory 
from the system RAM. As this graphic 
interface is one of the primary features 
of Vista, you would need to install 
a separate video card which meets 
the requirements of the Vista video 
specification. For the computers I 
was building this was not a problem 
as they will not be running Vista. 
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Instead I purchased 2 OEM copies 
of Windows XP which run very well 
with the integrated graphics on this 
Intel board.

The Intel motherboard also requires 
DDR2 RAM (system memory) modules 
which improve the processing speed 
over that of the original DDR RAM. It 
also has a front-side bus which can run 
at 533, 800 or 1066 MHz. 

With the Celeron D this bus runs 
at 533 MHz. For those who are not 
familiar with bus speeds, the front 
side bus refers to the speed at which 
information is transferred to/from the 
various peripheral slots to the CPU. In 
today’s computers this can be one of 
the bottlenecks for data transfer. The 
other is the Input/Output transfer for the 
hard drive. Other features of this board 
include 8 USB 2.0 ports, a 10/100 LAN 
port and four SATA hard drive ports.

I  have always found Intel 
motherboards to be very solid and 
dependable performers. If I were intent 
on building a faster system with a Core-
2 Duo or AMD processor then I would 
be looking for an ASUS motherboard. 
In general they get much stronger 
reviews related to state-of-the-art 
installations. I have also used them in a 
number of systems some of which are 
still running some five years later. So I 
always consider them for a top-of-the- 
line system.

The next item I considered was 
the case for these systems. The one I 
selected was an Antec Sonata II which 
is a mid-size tower. This comes with an 
air control system that channels air from 
outside the case directly to the CPU. It 
has a 120 mm exhaust fan and provisions 
for an additional fan in the front of the 
case. The Antec power supply provides 
450 watts maximum and has two 
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fans. The exhaust fan runs only when 
the power supply reaches a specific 
temperature. As it turned out, this was 
the quietest case I have ever used. The 
fans are really whisper quiet. With any 
ambient noise in the work space you 
really can’t hear the computer. This is 
also related to the shock mounting of 
the hard drives. The hard drive cage 
has individual removable mounts with 
rubber grommets around the attachment 
screws. Each drive is therefore mounted 
on these rubber grommets and essentially 
no vibration is transmitted to the cage 
or the case.

One thing I haven’t mentioned 
yet is the RAM I installed. For these 
computers, considering how they were 
to be used, I only installed one GB of 
RAM. This was one Kingston 1GB 
DDR2 240 pin module for each system. 
This leaves one slot open for additional 
memory should an upgrade be needed.

Installation of the components into 
the case is not really difficult. The first 
part is to screw in the motherboard 
supports and to replace the I/O shield at 
the back with the one supplied with the 
motherboard. I always install the CPU, 
the CPU fan and the RAM before I try 
to put the motherboard in the case. Then 
the trick in getting the motherboard into 
position is to make sure that you tilt it 
toward the back so it fits the I/O shield 
and then lay it on the supports. You 
generally have to put a little pressure 
on the front edge of the motherboard 
to get the screw holes lined up. Once 
it is screwed down you can install 
the power connectors and the various 
connectors for the LEDs and front 
panel USB connectors. The Antec case 
manual is quite helpful in this regard. 
The Intel instructions are all pictorial 
and might take some thinking if you’ve 



never done this before. I found that the 
ASUS motherboard manuals are much 
better designed for non-commercial 
installers. Intel obviously figures that 
anyone using their motherboard has 
done this before.

Now we get to another really 
important component, the hard drive. 
As I mentioned earlier the motherboard 
supports up to four SATA (serial 
ATA) drives. So I selected Seagate 
Barracuda SATA2 160 GB hard drives 
for these systems. I went with Seagate 
because I have found over the years 
that they are more reliable than other 
brands. Even though some are now 
Seagate subsidiaries, I still prefer 
the Seagate label. Also, I would not 
consider installing IDE drives in any 
new computers. The transfer rates for 
SATA2 are so much better it doesn’t 
make sense to install an IDE drive 
anymore. The other point is that the 
price of SATA2 is quite competitive 
with IDE. I suspect that it won’t be 
long before it will be very difficult to 
find IDE drives. Oh yes, the cost of 160 
GB drives is only a few dollars more 
than an 80 GB drive. And, you can go 
up to 500 GB for not much more. The 
attachment to the motherboard uses a 
power cable from the power supply and 
the data cable which comes with the 
motherboard. Each of these are keyed 
so they fit only one way into the drive 
and the motherboard.

At this point I usually do a power-on 
test to see if everything wakes up. So, I 
connect the video monitor and external 
power, then press the power switch. 
Once the power connection is made 
the motherboard LED lights up. Then, 
pressing the power on results in the case 
fan and CPU fan spinning. Of course, 
I get an error message on the monitor 
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that there is no operating system. But 
everything else looks good, so I just 
hold in the power button until the system 
powers down. Then I disconnect the 
power and video.

The only other internal drive that I 
installed was a NEC DVD burner. This 
fits into one of the exposed 5¼” drive 
slots. To get this in you have to remove 
one of the slot covers. The easiest way 
in the Antec case is to push it out from 
the inside. Then on the back of this 
cover are two rails that are removed 
and attached to the DVD drive with 
the supplied screws. Then you simply 
slide the drive in so it is supported 
by the rails. The motherboard comes 
with an IDE cable that attaches to the 
motherboard and to the drive. Each 
end is keyed so you really can’t attach 
it incorrectly. These systems did not 
require a floppy drive.

The monitors I selected for these 
systems are Samsung 17” LCD. The 
monitors have an adjustable height 
stand and can be rotated for either 
portrait or landscape orientation. The 
contrast ratio is one of the highest I’ve 
seen for LCD monitors. In addition, I 
didn’t find any dead pixels in any of 
the three systems I purchased. I’ve had 
similar success with other Samsung 
monitors I have installed.

The final hardware components 
are the mouse, keyboard and speakers. 
The speakers for these systems are 
an inexpensive CyberAcoustic set 
since they are headed for an office 
environment. You can certainly find 
better and more expensive speakers if 
you prefer. The keyboard and mouse are 
a wireless combination from Logitech. 
As I use Logitech’s wireless systems, I 
find I really like the way they operate. 
The only drawback is that they do 



require batteries. However, in the mouse 
that I use with my laptop, the two AA 
alkaline batteries lasted for a year.  The 
mouse and keyboard operate using 
an RF (radio frequency) receiver that 
plugs into the PS/2 ports on the case. 
With Windows XP both of these were 
immediately recognized as being the 
usual PS/2 components.

As I mentioned earlier, the operating 
system for these computers is Windows 
XP. After I had all the components 
installed, I put the Windows CD in the 
drive and rebooted the computer. The 
system booted from the CD with no 
problem. Then all that was needed was 
to follow the on-screen instructions 
to partition and format the new drive. 
After that, Windows continued with 
the installation of XP. That took about 
30 minutes after the completion of the 
drive formatting.

The final steps in the preparation of 
these systems was the downloading of 
various software components. These 
included Firefox, Avast anti-virus, 
ZoneAlarm firewall, Spybot, Spyware 
Blaster, Ad-Aware and the OpenOffice 
software suite. I can highly recommend 
all of these components as I have used 
them myself for multiple years and 
installed them on many other computers. 
Oh yes, the total cost for each system, 
including the monitors was just over 
$800.00. Sure, you can buy a computer 
for less, but you may not get what I 
consider to be quality components. And, 
you won’t know your system as well as 
the one you built.

How long does it take to assemble 
a computer? With experience, it will 
take a few hours. If you have never 
done it before, I suspect it could be 
4-8 hours. But, like anything else, 
when you do it yourself there is a great 
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deal of satisfaction obtained from a 
final working system. Who knows, 
you might enjoy trying it. Even if you 
don’t, I hope this article has given 
you some additional insight into the 
workings inside that “black box” called 
a computer.

Dr. Lewis is a Columnist, Sarasota 
PCUG, Florida <http://www.spcug.
org> and a former university and 
medical school professor, but not 
in computer science. He has been 
working with personal computers for 
over thirty years teaching, repairing, 
assembling and writing software for 
computer systems. He can be reached 
at <bwsail at yahoo.com>.

This article has been provided 
to APCUG by the author solely for 
publication by APCUG member 
groups. All other uses require the 
permission of the author (see e-mail 
address above).
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Secure Your Flash Drive Cap 
By Fran Damratowski

Obtained from APCUG with the 
author’s permission for publication by 
APCUG member groups.

Have you ever misplaced your flash 
drive cap? No need to ever do that again. 
Secure it with a button. You will need:
•	 a shirt button,
•	 some heavy thread such as carpet 

thread,
•	 double sided self-sticking adhesive 

mounting foam,
•	 double sided sticky tape, and
•	 some colorless nail polish.
Procedure
1.	 Run the thread diagonally through 

two of the buttonholes and secure 
with a square knot.

http://www.spcug.org
http://www.spcug.org
mailto:bwsail@yahoo.com


Computer History
1977: First Annual West 
Coast Computer Faire 
held in San Francisco.
2.	 Place the knot on the top of the 
button, not on the flat bottom of the 
button.

3.	 Cut the thread long enough to secure 
it with enough play to remove the 
cap.

4.	 Cut a small piece of the double-sided 
self-sticking adhesive mounting 
foam about the size of the button.

5.	 Remove the backing from one side 
of the double-sided self-sticking 
adhesive mounting foam and place 
a small piece of the double-sided 
sticky tape on the sticky side of the 
double-sided self-sticking adhesive 
mounting foam. (The double-sided 
self-sticking adhesive mounting 
foam does not hold well without the 
sticky tape. The tape alone does not 
hold well either.)

6.	 Securely attach the flat side of the 
button to the sticky tape.

7.	 Trim the excess tape and foam using 
an X-Acto knife.

8.	 Remove the backing from the other 
side of the double-sided self-sticking 
adhesive mounting foam and place 
another piece of double-sided sticky 
tape on the foam.

9.	 Securely attach the button foam and 
tape to the flash drive cap.

10.	Secure the other end of the thread to 
the flash drive or lanyard.

11.	Leave enough play to easily remove 
the cap, but not get tangled.

12.	Use the colorless nail polish to secure 
the knots so they don’t become 
undone.

13.	After the nail polish dries trim the 
thread.

OR
You could go to your local photo shop 
and buy a $2+ button sized lens cap 
keeper (or cap retainer) and modify 
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BOARD MEETING 
06/10/2007 

Chuck Moery

BOARD MEMBERS PRESENT
President Gary DeNise, Treasurer Bette 
Gay, SIG-Advanced Chairman Franz 
Breidenich, SIG-IBM Co-Chairman 
Tom Callow, SIG-IBM Intermediate 
Chairman Carl Massie, Jr., Publications 
Committee Chairman Warner Mach, 
and Members-at-Large Bob Clyne 
and Chuck Moery. Also present was 
Internet Committee Chairman Mike 
Bader. The meeting was called to order 
by Gary DeNise at 12:10 p.m.
OLD BUSINESS
Bette Gay reported that the June 
Treasury consisted of $3,718.49 in 
the Checking Account and $4,523.36 
invested in three Certificates of Deposit 
for an overall total of $8,241.85. The 
membership currently is 81. There are 
currently 10 Complimentary DATA 
BUS recipients on the distribution list. 
It is time for Jerry Comptois and Al 
Gruber to renew their membership. 
NEW BUSINESS
Tom Callow moved to reimburse Gary 
DeNise $7.44 for refreshments. Bob 
Clyne seconded the motion and it was 
carried.

Bob Clyne moved to adjourn. Gary 
DeNise seconded the motion and the 
motion was carried. The meeting 
adjourned at 12:20 p.m.



39

August  2007 DATA BUS DEADLINE (7th day after 2nd Sunday in month) 
SEMCO Input and Members’ Ads — Deadline: Sun., July 15, 11:59 p.m.
Members’ personal ads are free. To mail, use Editor address on Page 2; e-mail address: 
<machw@att.net>. PLEASE send to arrive sooner than deadline.
Business Ads - Deadline: Second Friday monthly. Contact Editor (address Page 2).

SIG-ADVANCED
Franz Breidenich

July 8: Help Q & A: Discussion 
directed by the audience. No question 
is too simple! 

SPECIAL INTEREST GROUPS (SIGS)

SIG-IBM 
Tom Callow

Warner Mach
SIG-IBM INTERMEDIATE 

Carl Massie, Jr.

NOVICE-IBM GROUP
Rotating Volunteer Hosts

July 8: “Wikinomics How Mass 
Collaboration Changes Everything”: 
SIG-IBM Intermediate Chairman, Carl 
Massie Jr. discusses the book by Don 
Tapscott and Anthony D. Williams 
which offers a view and a vision of the 
emerging global economy. Examples 
taken from the book and others taken 
from current events will be offered of 
the transformations that are occurring 
in corporations. From the book: “For 
individuals and small producers, this 
may be the birth of a new era, on par 
with the Italian renaissance or the rise 
of Athenian democracy.”

July 8: Excel Revisited—Part 2:  
Long-time SEMCO member Bill 
Landrum concludes his two-part 
presentation on Excel spreadsheets. The 
use of Excel arrays will be considered 
briefly, but the major emphasis will be 
on three topics: (a) importing external 
data into a spreadsheet and linking to an 
external database table via SQL, (b) the 
building and use of pivot tables, and (c) 
creating and using VBA macros.

Bill will use Excel XP for the demos, 
but everything shown should work on 
Excel from Excel 4 (1992) through 
Excel 2007.

August 6, 2007: (First Monday), 6:45 
p.m, at the Oak Park Library. The library 
is located at 14200 Oak Park Blvd., 
Oak Park, MI. Phone: (248) 691-7480. 
Topic: Wide ranging discussion of 
computers and computing.

mailto:machw@att.net
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CALENDAR-OF-EVENTS
OTHER GROUPS

Warner Mach
machw@att.net

(to post monthly computer group info)

COMP (Computer Operators of Marysville & Port Huron)	 
September 5, 7 p.m., (1st Wednesday); St. Clair County RESA, 499 Range Rd., 
Marysv i l l e ,  Admin .  Bu i ld ing .  J ane  Whea t ly  8 10 -98 2 -1187 
 <http://www.bwcomp.org>. Topic: TBA.
DCOM Computer Club	  
August 17, 6:30–8:30 p.m., (2nd Friday); Henry Ford C.C., Patterson Tech Bldg, 
Ford Rd/Evergreen, Rm T143, Parking Lot C. Info: Doug Piazza 313-582-2602.
MacGroup- Detroit	  
July 22, 2:15 p.m.–5 p.m.; Birmingham Temple, 28611 West 12 Mile Rd., 
Farmington Hills. Info: Terry White, <terry@macgroup.org> or 313-571-9817. 
<http://www.macgroup.org>. Topic: Digital Photography Workflows with Adobe 
Photoshop Lightroom.
MacTechnics, (MAC User Group)	  
July 21, 11:00 a.m., (3rd Saturday); (SIGs at 9:30); Washtenaw County Learning 
Library, 4135 Washtenaw Ave., Ann Arbor. <http://www.mactechnics.org>). Cassie 
at <cassiemac@yahoo.com> or 313‑971‑8743.
MDLUG (Metro Detroit Linux User Group)	  
July 14, 12:30–2:30 p.m., (2nd Saturday); MDLUG meetings will be at  
The Gaudior Academy located at 27100 Avondale Avenue in Inkster. Web: 
<http://www.mdlug.org>. Info: Raymond McLaughlin 248-960-1864. 
Michigan Apple Computer User Group	  
July 12, 7:30 p.m., (2nd Thur.); General meeting; Fraternal Order of Eagles Hall in 
Clawson, 174 Bowers St. (one block North of 14-Mile and one block East of Main). 
Avi Drissman 248-232-7865. Web: <http://www.themichiganapple.com>.
MUG (Michigan User Group)	  
July 10, 6:00 p.m., (2nd  Tuesday): MUG meetings are at The Farmington Community 
Library–Main Branch, 32737 W. 12 Mile Rd., Farminton Hills, MI. 48334. Web: 
<http://www.mug.org>.
Oak Park Computer Club	  
Every Fri., 10:15 a.m. at Oak Park Recreation Bldg, Oak Park Blvd. west of 
Coolidge.
SHCC (Sterling Heights Computer Club) 	 
September 4, 7:30 p.m., (1st Tuesday); Macomb Community College South 
Campus, Bldg. K, 14500 E. 12 Mile Rd. Don VanSyckel <Don@VanSyckel.net>, 
586‑731‑9232; Web: <http://www.SterlingHeightsComputerClub.org>. Topic: 
Wireless and Other Wonders of Home Networking.
Wayne State University Mac User Group 	 
August 11, 10:00 a.m.–Noon, (2nd Saturday); at Mich.com, 21042 Laurelwood, 
Farmington. Information: Lorn/JoAnn Olsen 248/478-4300 or Denny MeLampy 
248‑477-0190.

mailto:machw@att.net
http://www.bwcomp.org
mailto:terry@macgroup.org
http://www.macgroup.org
http://www.mactechnics.org
mailto:cassiemac@yahoo.com
http://www.mdlug.org
http://www.themichiganapple.com
http://www.mug.org
mailto:Don@VanSyckel.net
http://www.SterlingHeightsComputerClub.org
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REFRESHMENT 

DONORS
Gary DeNise, Coordinator 

Al Bochenek 
Gary DeNise 

Kaye Johnson 
Warner Mach 

Betty Mackenzie 
Roland Maki

Continued from page 38

it as needed. Most of them appear to 
come with elastic bands that are placed 
around the lens barrel as opposed to a 
leash that can be attached to another part 
of the camera.

Fran Damratowski i s the 
Refurbishing SIG Leader for the 
Chesapeake PC Users Group, MD 
<http://www.chesapeakepcusersgroup.
org> and can be reached at <refurbishi
ng(at)chesapeakepcusersgroup.org>.

This article has been provided 
to APCUG by the author solely for 
publication by APCUG member 
groups. All other uses require the 
permission of the author (see e-mail 
address above).
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COMPUTER RESOURCE PEOPLE
This is a list of members willing to be resources for other members to call when they have hardware 

or software questions. 
Are you willing to help members learn?

Which software programs are you familiar enough with?
It is not necessary to be an expert, but just have some familiarity with the program and be willing to help 
someone starting to learn it. Please give this some thought and volunteer at the next group meeting.

Almost Anything: Vander-Schrier 		  MS Office for Windows: Callow 
AutoCAD: Comptois			   MS Word: Clyne 
Genealogy: Cook	 			   Networking: Callow 
IBM PC Hardware Issues: Clyne, Yuhasz	 Novell Netware: Yuhasz 
Operating Systems: Callow, Clyne, Yuhasz	 Quicken: Clyne 
MAC Hardware and OS Issues: Yuhasz		  Geocaching: Cook 
Security: Bader

Bader, Mike—586-573-7330, 9am–8pm.................... mdbader@flash.net
Callow, Tom—248-642-5770 9am–5pm.................... tcallow@monaghanpc.com 
Clyne, Bob—810-387-3101, 9am–10pm................... clyne@lodden.com
Comptois, Jerry—248-651-2504, anytime
Cook, Stephen—313-272-7594, eves......................... scook48227@ameritech.net
Vander-Schrier, Jack—586-739-7720,12–8pm...........jvanders@myself.com
Yuhasz, Steve...............................................................Help@yuhasz.org

STILL NEEDED: A VOLUNTEER 
TO BE REFRESHMENTS 

COORDINATOR

mailto:mdbader@flash.net
mailto:tcallow@monaghanpc.com
mailto:clyne@lodden.com
mailto:scook48227@ameritech.net
mailto:jvanders@myself.com
mailto:Help@yuhasz.org
http://www.chesapeakepcusersgroup.org
http://www.chesapeakepcusersgroup.org
mailto:refurbishing@chesapeakepcusersgroup.org
mailto:refurbishing@chesapeakepcusersgroup.org
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SEMCO CALENDAR
ArvinMeritor Building 
2135 West Maple Road 

Troy, Michigan
July 8–SUNDAY (Meet 2nd Sunday)

SEMCO Board Meeting at 12:00 noon. For Officers and SIG Chairpersons. 
Other members are invited to attend. 

SEMCO General Meeting at 1:30 p.m. 
Special Interest Groups (SIGs)

SIG-IBM 1:45 p.m. Program: Excel Revisited—Part 2: Long-time SEMCO 
member Bill Landrum concludes his two-part presentation on Excel spreadsheets. 
The use of Excel arrays will be considered briefly, but the major emphasis will 
be on: (a) importing external data into a spreadsheet and linking to an external 
database table via SQL, (b) the building and use of pivot tables, and (c) creating 
and using VBA macros. 
SOCIAL PERIOD 3:15 p.m. Refreshments! (Reminder: We must continue to 
maintain a neat environment.)
NOVICE-IBM GROUP 3:45 p.m. Program: Help From An Expert With 
Discussion Directed By The Audience.
SIG-IBM Intermediate 3:45 p.m. Program: “Wikinomics How Mass 
Collaboration Changes Everything”: SIG-IBM Intermediate Chairman, Carl 
Massie Jr. discusses the book by Don Tapscott and Anthony D. Williams which 
offers a view and a vision of the emerging global economy. Examples taken from 
the book and others taken from current events will be offered of the transformations 
that are occurring in corporations.
SIG-ADVANCED, August 6, 2007–MONDAY, 6:45 p.m., (First Monday), Oak 
Park Public Library, 14200 Oak Park Blvd.,Oak Park, MI. Phone: (248) 691‑7480. 
Directions: Oak Park Blvd. is 9 1/2 mile Road; library is west of Coolidge. 
Info: Franz Breidenich 248‑398‑3359. TOPIC: Wide-Ranging Discussion Of 
Computers & Computing.
August 12–SEMCO Sunday

http://www.semco.org
PUBLIC INVITED

(Please copy this and the next page to post on your bulletin board)

 SOUTHEASTERN MICHIGAN 
COMPUTER ORGANIZATION, INC.

http://www.semco.org
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SEMCO Meetings at ArvinMeritor 
2135 West Maple Road, Troy, MI 48084

DIRECTIONS
From I-75, take Exit 69 to westbound Big Beaver Rd. (16 Mile). Turn left (South) 
on Crooks Rd. Turn right (West) on Maple Rd. (15 Mile). Turn left (South) on 
Maplelawn Dr. Turn right into the parking lot at the rear of the ArvinMeritor build-
ing. The building is shaped like an X. Enter the building thru the South entrance at 
the center of the rear of the building. Follow the SEMCO signs.

SEMCO thanks the ArvinMeritor Corpora-
tion for their hospitality in providing their 
facility for our meetings.

S

N

http://www.arvinmeritor.com
http://www.apcug.net
http://www.arvinmeritor.com
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